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Symbols

On the FS-2/2E Unit 

The lightning flash with arrowhead symbol, within an equilateral 
triangle, is intended to alert the user to the presence of an 
uninsulated Dangerous Voltage within the product’s enclosure that 
may be of sufficient magnitude to constitute a risk of electric shock 
to persons.

Caution
For continued protection against fire, replace only with fuses of 
correct rating, as listed on the rear panel.

Caution 
TO PREVENT THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE 
COVER (OR BACK). NO USER SERVICEABLE PARTS INSIDE. REFER 
SERVICING TO QUALIFIED SERVICE PERSONNEL.

    In the FS-2/2E Documentation

The exclamation point within an equilateral triangle is intended to 
alert the user to the presence of important operating and 
maintenance (servicing) instructions in the literature 
accompanying the device.



Notices: Legal, Regulatory, and Safety
LEGAL NOTICES

THIS DOCUMENT CONTAINS CONFIDENTIAL AND TRADE SECRET 
INFORMATION OF FOCUS ENHANCEMENTS AND ITS RECEIPT OR 
POSSESSION DOES NOT CONVEY ANY RIGHTS TO REPRODUCE OR 
DISCLOSE ITS CONTENTS, OR TO MANUFACTURE, USE, OR SELL 
ANYTHING THAT IT MAY DESCRIBE. REPRODUCING, DISCLOSING, OR 
USING IN WHOLE OR IN PART WITHOUT THE SPECIFIC WRITTEN 
AUTHORIZATION OF FOCUS ENHANCEMENTS IS STRICTLY FORBIDDEN.

EVERY EFFORT HAS BEEN MADE TO ENSURE THAT THE INFORMATION IN 
THIS DOCUMENT IS COMPLETE AND ACCURATE AT THE TIME OF 
PRINTING; HOWEVER, THE INFORMATION CONTAINED IN THIS 
DOCUMENT IS SUBJECT TO CHANGE.

Copyright
Copyright 2006 FOCUS ENHANCEMENTS 

All Rights Reserved

The material contained in this document is also protected by copyright laws of the 
United States of America and other countries. It may not be reproduced or 
distributed in any form by any means, altered in any fashion, or stored in a data 
base or retrieval system, without express written permission of FOCUS 
ENHANCEMENTS. 

FOCUS ENHANCEMENTS is responsible for unauthorized use of equipment and 
does not make allowance or credit for unauthorized use or access.
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Contacting FOCUS ENHANCEMENTS   

Serial Number
The serial number for this equipment is located on the bottom of the unit. Please 
write this serial number on the enclosed warranty card and keep it in a secure area.

Registering Products, Technical Support, and Warranty 
To register a Focus Enhancements product use the online form at: 
http://www.focusinfo.com/rfi/warranty.asp.

For questions about technical support or warranty, contact the seller, distributor, or 
contact Focus Enhancements by email: support@focusinfo.com. 

Unauthorized Use

Focus Enhancements is not responsible for the unauthorized use of its 
equipment and will not make allowance or credit for unauthorized use or 
access.

Unauthorized Alterations and Modifications

Alterations or modifications to Focus Enhancements equipment or software 
that is carried out without appropriate authorization may invalidate the 
product warranties and the user's right to operate the equipment.

USA

Office Hours: Monday through Friday
8:00 AM to 5:00PM (Central Time)

Email: support@focusinfo.com

Telephone: +1 763-398-1658

Fax: +1 763-571-7688

Address: Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

EMEA (Europe, Middle East, Africa) 
Office Hours: Monday through Friday

9:00 AM to 5:00PM 

Email: techsupport@como.com

Telephone: +49 4307 - 83 58 58

Fax: +49 4307 - 83 58 99

Address: COMO Computer & Motion GmbHA 
A Focus Enhancements Company
Lise-Meitner-Str. 15
24223 Raisdorf / Germany
www.focusinfo.com
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Unauthorized Servicing

Do not attempt to service this product yourself. Opening or removing 
covers may expose dangerous voltage or other hazards. 

Refer all servicing to qualified service personnel. 

Returning Materials 

End Users

If the FS-2/2E was not purchased directly from Focus Enhancements, it is 
necessary to contact the seller and determine what procedure is needed for 
repairing the converter.

Direct Sales 
(VARs, Distributors, and Corporate Customers 

If the FS-2/2E has problems that cannot be corrected over the telephone by 
Focus Enhancements technical support, it may be necessary to return the 
converter to Focus Enhancements.

To contact Focus Enhancements:    

All materials shipped back to Focus Enhancements must be accompanied 
by a Return Materials Authorization (RMA) number. Contact Focus 
Enhancements Technical Support to receive a RMA number. 

Write the RMA number clearly on the shipping label.

Office Hours: Monday through Friday
8:00 AM to 5:00PM (Central Time)

Email: support@focusinfo.com

Telephone: 763-398-1658

Fax: 763-571-7688

Address: Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com
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Regulatory and Safety

Environmental Precaution

FCC Class A
This product satisfies FCC regulations when shielded cables and connectors are 
used to connect the unit to other equipment. To prevent electromagnetic 
interference with electric appliances such as radios and televisions, use shielded 
cables and connectors.

This equipment has been tested and found to comply within the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, correct the interference by 
one or more of the following:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different from that used by the 

receiver.
• Consult the dealer or an experienced radio/TV technician for help. 

Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008

Model Number: FS2-2E

Date of Manufacture:
Reference the Serial Number label attached to the unit.
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Documentation
This manual is written with the assumption that the user is familiar with analog 
and digital video/audio signals and hardware.

Read, Retain, and Follow Instructions

All the safety and operating instructions should be read before the product 
is operated.

• Retain Documentation
Place documentation in a secure place for future reference on 
operating and safety instructions.

• Follow All Operating and Safety Instructions

Pay Attention to All Warnings 

Warnings are provided to protect the operator, the equipment, and content.  

This symbol indicates information about features, functions, operations, that is 
of interest to the user. 
FS-2/2E Studio DTE Disk Recorder User Guide
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Electrical Precautions

Do Not Expose to Moisture

Do not use this product near water or in an environment where it is 
exposed to dampness or there is the possibility of it getting wet.

Do Not Remove Cover

There are No User Serviceable Parts inside this unit. Servicing should be done 
by qualified service personnel.

ON / OFF Switch in Stand-By Position

The On/Off switch Does Not Separate the Unit From the Main Power when it is 
in the stand-by position.

Power Sources

Use only power sources that match those indicated on the marking label. If 
unsure of the type of power supply that is available, consult your dealer or 
local power company.

Do Not Overload Power Outlets

Do not overload wall outlets, extension cords, or integral convenience 
receptacles as this can result in a risk of fire or electric shock.

Verify Power Plugs are Fully Inserted

To prevent potential electrical shock to personnel, verify that the FS-2/2E 
power cord plug is fully inserted into a grounded receptor and that the 
plug blades are not exposed.

ATTENTION 

POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS UTILISER CETTE 
FICHE POLARISEE AVEC UN PROLONGATEUR, UNE PRISE DE 
COURANT OU UNE AUTRE SORTIE DE COURANT, SAUF SI LES 
LAMES PEUVENT ETRE INSEREES A FOND SANS EN LAISSER 
AUCUNE PARTIE A DECOUVERT.

Power-Cord Protection 

• Routing Power-Cords 
Route power supply cords so that they are not likely to be walked on 
or pinched by items placed upon or against them. Avoid sharp angles 
in the cord, particularly at plugs, convenience receptacles, and the 
point where they exit the product.

• Non-Use Period
During extended periods when the device is not used, unplug it from 
the power source and retract the power-cord.
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Grounding or Polarization

• Polarized 
If this product is equipped with a polarized alternating current line 
plug (a plug having one blade wider than the other), it will fit into the 
outlet only one way. This is a safety feature. If you are unable to insert 
the plug fully into the outlet, try reversing the plug. If the plug should 
still fail to fit, contact your electrician to replace your obsolete outlet. 
Do not defeat the safety purpose of the polarized plug.

• Grounded 
If this product is equipped with a three-wire grounding type plug, a 
plug having a third (grounding) pin, it will only fit into a grounding 
type power outlet. This is a safety feature. If you are unable to insert 
the plug into the outlet, contact your electrician to replace your 
obsolete outlet. Do not defeat the safety purpose of the grounding 
type plug.

Outdoor Antenna Grounding

If an outside antenna or 
cable system is connected to 
the FS-2/2E, verify that the 
antenna or cable system is 
grounded. This provides 
some protection against 
voltage surges and built-up 
static charges. 

Refer to Article 810 of the 
National Electric Code, 
ANSI/NFPA 70, for 
information about the 

proper grounding of the mast and supporting structure, grounding of the 
lead-in wire to an antenna discharge unit, size of grounding connectors, 
location of antenna discharge unit, connection to grounding electrodes, and 
requirements for the grounding electrode. See Fig. A. 

Lightning and Power Surges

During electrical storms or when left unattended and unused for long 
periods of time, unplug the FS-2/2E from the power source and disconnect 
the antenna or cable system.

Power Lines

Do not locate an outside antenna system in the vicinity of overhead power 
lines, electric light or power circuits, or where it can fall onto such lines or 
circuits.
FS-2/2E Studio DTE Disk Recorder User Guide
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When installing an outside antenna system, extreme care should be taken to 
keep from touching such power lines or circuits as contact with them might 
be fatal.

Optical Precaution
The use of optical instruments with this device will increase hazards to the eyes 
hazard.

Maintenance and Moving

Cleaning

Unplug this product from the wall outlet before cleaning. The product 
should be cleaned only with a polishing cloth or a soft dry cloth. Never 
clean with furniture wax, benzine, insecticides or other volatile liquids 
since they may corrode the cabinet. 

Servicing 

Unplug the device from the power outlet and refer servicing to qualified 
service personnel under the following conditions:

• When the power-supply cord or plug is damaged.
• If liquid has been spilled, or objects have fallen into the product.
• If the product has been exposed to rain or water.
• If the product does not operate normally when following the 

operating instructions. Adjust only those controls that are covered by 
the operating instructions. The incorrect adjustment of other controls 
can result in damage and often requires extensive work by a qualified 
technician to restore the product to its normal operation.

• If the product has been dropped or damaged in any way.
• When the product exhibits a distinct change in performance.

Accessories and Replacement Parts 

Use only attachments and accessories recommended by Focus 
Enhancements. 

Use only replacement parts specified by the Focus Enhancements or of 
comparable quality and characteristics as the original parts.

Unauthorized substitution of parts can result in fire, electrical shock, other 
hazards, and loss of warranty.
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Safety Check

Upon completion of any service or repairs to this product, ask the service 
technician to perform safety checks to determine that the product is in 
proper operating condition.

Operating Environment

Location

Install this device on a sturdy, level surface, away from moisture and dust.
• Heat 

Locate this device away from heat sources such as radiators, heat 
registers, stoves or other electrical devices (including amplifiers) that 
generate heat.

• Wall or Ceiling Mounts 
This device should not be mounted to a wall or ceiling. 
Any mounting of this device should follow its instructions, and 
should use only mounting accessories recommended by Focus 
Enhancements.

Moving

• Use appropriate safe lifting practices.
• Do not over load or unbalance carts when moving product.

Ventilation

Do not block the ventilation openings in the FS-2/2E cabinet. Overheating 
can occur and damage the device. Do not place this device in a built-in 
installation, such as a bookcase or rack, unless proper ventilation is 
provided.
FS-2/2E Studio DTE Disk Recorder User Guide
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WARRANTY

For customers within the USA and Canada, FOCUS ENHANCEMENTS, Inc. 
warrants this product against defects in materials or workmanship as follows: 

For a period of TWO years from the date of purchase, FOCUS ENHANCEMENTS, 
Inc. will repair or replace the unit, at our option, without charge for parts or labor. 
After the period of TWO years, you must pay all parts and labor charges.

 The limited warranty is extended only to the original purchaser. It does not cover 
damage or failure caused by or attributable to Acts of God, abuse, misuse, 
improper or abnormal usage, faulty installation, improper maintenance, lightning, 
or other incidences of excessive voltage, or any repairs or tampering by other than 
the FOCUS ENHANCEMENTS repair facility. It does not cover replacement of 
batteries or other consumable parts, transportation costs or damage in transit. This 
warranty will become void if the serial number or model number identification has 
been wholly or partially removed or erased. Repair or replacement under the terms 
of this warranty do not extend the terms of this warranty. Repairs or replacement 
performed outside of the warranty period will carry a warranty for 60 days from 
return shipment. This warranty can not be modified by an agent of FOCUS 
ENHANCEMENTS, Inc. unless in written and signed by an officer of FOCUS 
ENHANCEMENTS, Inc. 

Should this product prove defective in workmanship or material, the consumer's 
sole remedies shall be such repair or replacement provided by the terms of this 
warranty. Under no circumstances shall FOCUS ENHANCEMENTS, Inc. be liable 
for any loss or damage, direct, consequential, or incidental, arising out of the use of 
or inability to use this product. Some states do not allow limitations on how long 
an implied warranty lasts or the exclusions or limitations of incidental or 
consequential damages, so the above limitations or exclusions may not apply to 
you. This warranty gives you specific legal rights. You may also have other rights 
which vary from state to state.
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Chapter 1

Introduction
Thank you for purchasing the Focus Enhancements FS-2/2E DTE DV Studio Disk 
Recorder. 

The FS-2/2E is designed for use as a record or playback device in studios, mobile 
vans and other installations.

The purpose of this User Guide is to explain the features and operation of the FS-2/
2E. Study the contents of this User Guide before attempting to use your FS-2/2E. 

Check the Focus Enhancements website regularly for updates to FS-2/2E software 
and documentation: www.focusinfo.com/support.

Alternatively, contact your Focus Enhancements dealer/distributor.

This chapter contains the following sections:
What is a DTE Disk Recorder? page 2
What is the FS-2/2E? page 2
Basic Applications page 3
Receiving, Unpacking, and Inspecting page 3
Package Contents page 4
Installation and Site Requirements page 5
Mounting in a 19 inch Electronics Rack page 6
Inserting the Internal 3.5 inch IDE Drive page 7
Using External Disk Drives page 7
Physical Features page 8
Setting Up the FS-2/2E page 12
Formatting the Drive page 13
Setting the Time and Date page 14
Replacing the Power Module Fuse page 15

FS-2E Provides Greater Embedded Audio SDI Functionality
The FS-2E provides even more embedded audio SDI functionality. It includes the ability to 
selectively record either channels 1 and 2 or 3 and 4 of the embedded audio of the input SDI 
stream. It also provides full support of the SDI audio out. The FS-2E inserts the recorded audio 
into the SDI output stream. The FS-2 does not possess these capabilities.
FS-2/2E Studio DTE Disk Recorder User Guide
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1.1 What is a DTE Disk Recorder? 

A DTE Disk Recorder is a device that allows you to record or playback DV video 
directly to/from a removable IDE disk drive or removable FireWire disk drives. 
The FS-2/2E features analog and digital inputs and outputs including DV25, SDI, 
composite, component, S-Video, AES/EBU digital audio and balanced analog 
audio. 

Audio and video are recorded to disk as a DV25 data stream in NLE native file 
formats.

1.2 What is the FS-2/2E? 

The FS-2/2E is a DTE Disk Recorder that mounts horizontally in a standard 
electronics rack. With the FS-2/2E, it is possible to:

• Input DV25, SDI, composite, component, S-Video, AES/EBU digital audio 
and balanced analog audio and record to disk in native DV25 NLE file 
formats.

• Playback video from disk or transcode during recordings in DV25, SDI, 
composite, component, S-Video, AES/EBU digital audio and balanced analog 
audio formats. 

• Capture clips to hard disk at the acquisition stage. There is no need to capture 
them later.

• Record clips to disk in DTE Technology-based “edit-ready” file formats such 
as Raw DV, AVI Type 1, AVI Type 2, Matrox AVI, Canopus AVI, Pinnacle 
AVI, QuickTime and Avid DV-OMF. The FS-2E, and the FS-2 (with the 
version 2.0 upgrade), also include DTE support for 24P AVI Type 2 (NTSC 
only), and 24P Quicktime (NTSC only).This means clips are immediately 
available to your NLE system without first having to transfer or convert the 
files. 

• Connect your FireWire disk directly to your computer or connect it using FS-
2/2E which allows mounting and dismounting of the drives without re-
cabling or computer re-boots.

• Use the FS-2/2E's 10/100BaseT Ethernet port to share files over a network 
using FTP. This is not suggested for larger files. The FS-2E, and the FS-2 (with 
the version 2.0 upgrade), also include IP control of the FS-2/2E. This means 
you can control the FS-2/2E using a standard web browser.

• Jump from clip to clip without spooling through tape when in playback mode.
• As well as video, record and playback embedded DV audio in 2-channel (16-

bit, 48kHz) format.
• Record external timecode, embedded timecode or create your own timecode 

using Free Run, Regen or Rec Run time code options. You can also preset 
timecode and user-bit values.

• Record, play and navigate using FS-2/2E's VTR-style controls.
• Lock to your facilities Reference Video signal during playback and record.
E Studio DTE Disk Recorder User Guide     



Introduction
• Record and recall a single frame of DV video and record user definable time-
lapse sequences.

• Use trick playback modes up to 30X/-30X fast-forward and rewind speeds, 
reverse play, loop clip and loop entire disk.

• Control the FS-2/2E remotely using industry standard RS422 (Sony 9-pin), 
FireWire (for starting record/pause or AV/C) from a DV based camcorder 
1394 port. You can also control the FS-2/2E using RS-232C (using the optional 
wired remote control available as an accessory). The FS-2E, and the FS-2 (with 
the 2.0 software upgrade), can be controlled from your web browser using FS-
2/2E IP control. Refer to the section on the FS-2/2E Web Interface, FS-2E Web 
Interface on page 99.

• Create and save multiple playlists on the FS-2/2E. These can be shared 
between different units.

• Use the internal 120GB, 7200RPM, 3.5" IDE drive or daisy chain up to eight 
FireWire (IEEE-1394) hard drives together for extremely long, uninterrupted 
record times.

1.3 Basic Applications

You can use the FS-2/2E in the acquisition stage of production, the editing/post 
production stage, and the presentation stage. The FS-2/2E is most useful in the 
following applications:

• Presentation Video Source 
• Broadcast Tape Deck Replacement
• Time Lapse Recorder
• Film-to-Disk Transfer
• NLE/Linear Edit Source/Recorder
• Endless Video Program Looping
• Security Recorder/Player
• Medical Recorder/Player
• Industrial Monitoring
• Video DJ and Karaoke Player
• Outside Broadcast 

1.4 Receiving, Unpacking, and Inspecting

Upon receipt of the FS-2/2E unit, examine the shipping container. If there is 
evidence of damage or rough handling, have an agent of the carrier present when 
the equipment is unpacked.

Unpack the equipment carefully. Inspect it for scratches, dents, or cracks. If the 
equipment is damaged, save all packing materials and notify both Focus 
Enhancements and the carrier immediately.
FS-2/2E Studio DTE Disk Recorder User Guide
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1.4.1 Package Contents 

Please take a moment to study the contents of your FS-2/2E package. You 
should have the following contents:

1. One (1) FS-2/2E unit with attached rack mounting ears
2. One (1) 120GB IDE disk drive in caddy 
3. One (1) User Guide
4. One (1) 6-pin to 6-pin FireWire cable (for External Drive connection)
5. One (1) 6-pin to 6-pin FireWire cable (for front panel port loop) 
6. One (1) Focus Enhancement's DV Conversion Suite Demo Disk 
7. One Power Cord 
8. One (1) Focus Enhancement's Warranty Card and Statement (not 

shown)

If any of these items are missing, contact Focus Enhancements or your FS-
2/2E dealer/distributor immediately.

You may need to purchase cables to connect more than one hard disk drive 
to the FS-2/2E at a time. Your Focus Enhancements dealer can help you 
identify additional cables you may need.

6

7
4

5

3

1     

2
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1.5 Installation and Site Requirements

Focus Enhancements recommends that FS-2/2E units be installed in a restricted 
access area, such as an equipment room or closet and the installation be performed 
by trained installers.

The units are designed and tested to operate reliably between +5 - +40C (41 - 104 F).

To maintain this range, consider the following:
• Air temperature surrounding the equipment must remain within the specified 

range.
• Air flow around the equipment must be sufficient to maintain proper 

operating temperatures

If in doubt about the site temperature, take measurements to be certain. If 
measured temperatures fall outside the defined ambient temperature range, you 
must bring the temperature within the defined range.

Storage temperature for the units must remain between -20 - +60C (-4 - 140 F).
FS-2/2E Studio DTE Disk Recorder User Guide
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1.6 Mounting in a 19 inch Electronics Rack

The FS-2/2E measures 15.89” high x 17.36” wide by 3.47” deep. It is an 2RU chassis 
featuring front rack mount ears to be installed into a standard 19” audio/visual 
rack. There must be room behind the unit for the attachment of cables.

To mount the FS-2/2E in a standard 19” audio/visual rack, do the following:
1. Determine the desired location. 

The FS-2/2E requires 3.47 vertical inches of rack space. 
To prevent overheating, the FS-2/2E requires a minimum of 1.75 vertical 
inches of space above and below the unit. 

2. The FS-2/2E includes a pair of universal mounting ears on the front sides of 
the unit that support standard 19” audio/visual racks. Using the provided 
hardware, mount the FS-2/2E securely in the rack. 

3. Connect the FS-2/2E unit to the wall current using the attached power cord.

Universal Mounting EarsUniversal Mounting Ears

Mounting Screws
(2 per Mounting   ear)
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1.7 Connecting Hard Drives

1.7.1 Inserting the Internal 3.5 inch IDE Drive
Insert the internal 3.5 inch IDE drive as follows:

1. Remove the drive from its packaging.
2. Slide the drive carefully into the bay until it is seated firmly.

3. Press the Lock Handle flush with the chassis face to lock the drive in 
place.

To remove the drive, slide the Release Lever to the right. The Lock Handle 
disengages. Pull the drive toward you to remove it.

1.7.2 Using External Disk Drives
In addition to using a 3.5 inch IDE drive in the internal slot, you can also 
connect any FireWire disk drive to the HDD I/O port on the FS-2/2E. 
Power a single FireWire disk drive on the FS-2/2E at any given time. 

If you are using more than one external FireWire drive, you must provide 
external power to them. It may also be necessary to partition and format the 
drives before their use with the FS-2/2E. Refer to Formatting the Drive on 
page 13 for instructions on preparing drives before use. 

This drive is not intended for hot-swap operation.

Hot-swapping External FireWire Drives
You can hot-swap connected external FireWire HDDs on the FS-2/2E. This means 
you can disconnect and connect drives from the system without the need to power 
cycle the unit. However, make sure the FS-2/2E is in STOP mode before removing a 
disk drive.

Drive Bay

Release LeverLock Handle
FS-2/2E Studio DTE Disk Recorder User Guide
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1.8 Physical Features

The FS-2/2E features two main surfaces, the front control panel and the rear connector 
panel.

1.8.1 Front Control Panel
The front control panel contains the seven control areas, as shown in the illustration 
below and described in this section:

• Power Switch and Power LED
This is the FS-2/2E's main power switch. This switch, although mechanical, is 
controlled using software. When the power switch is set to ON and then OFF, 
in most cases the unit takes a moment to power down. During this time, the 
FS-2/2E is ensuring that any files that have not been closed properly in a 
record session get closed. This prevents errors occurring on particular files. 
The green LED above the power switch is ON when the unit is powered up.

• Disk Drive Bay
The disk drive bay accepts a standard 3 1/2” removable disk drive in the 
supplied sled. Minimum system requirements for this drive are 7200RPM 
with a 2MB cache. Drive performance may vary. Focus Enhancements 
recommends that you use a FS-2/2E qualified and tested disk drive. Check 
the Focus Enhancements website for an updated list. This bay is not intended 
for hot swap operation.

• Edit / Utility / Input Keys
These keys contain the edit, utility and input select functions for the FS-2/2E. 
In some cases, these buttons work in conjunction with the FS-2/2E menus on 
the display. 

Power Switch
and LED

Disk Drive Bay Edit / Utility / Input 
Keys

LCD
Display

Transport 
Keys

Soft KeysJack       Volume Control
Headphone

Jack       Volume Control
Headphone
-2/2E Studio DTE Disk Recorder User Guide     
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Input selections are either Composite, Y/C (S-Video), Component, SDI 
or DV. An audio source must be selected for each input using the 
SETUP > AUDIO INPUT menu, the Timecode mode in the 
SETUP > TC MODE menu, and the reference video source in the 
SETUP > GENLOCK > SOURCE menu. For component inputs/outputs 
you must select the video standard when used in NTSC mode only. 
Refer to Compnt Level on page 76 for more details.

• LCD Display
The FS-2/2E LCD displays the FS-2/2E’s current status including 
track number, disk number, timecode, record / playback mode as well 
as other information. It also displays the FS-2/2E menu system. The 
LCD is a green backlit 128x64 graphical display.

• Transport Control Keys
This set of keys controls playback and record functions of the FS-2/2E. 
These functions include play, reverse play, fast forward, fast rewind, 
forward frame, back frame, next track, previous track, stop, record, 
and so on. 

• Display Soft Keys
This set of keys enables you to navigate the FS-2/2E menus. The 
function of the keys varies depending on what is displayed at the base 
of the FS-2/2E LCD. Refer to LCD Menu Soft Keys on page 22 for more 
information.

• Headphone Jack (3.5mm) and Volume Knob
This jack is for connecting a pair of monitor headphones. You can 
monitor audio of the selected input (even if E-E is not selected) when 
not in record mode. When in record or playback mode, you can 
monitor the current audio. The headphone jack also includes a volume 
control.
FS-2/2E Studio DTE Disk Recorder User Guide
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1.8.2 Rear Connection Panel
The FS-2/2E rear panel, shown below, contains control and audio/video 
input/output areas described in this section.

You can select any of the available inputs as a source. When selected, that 
source is what is recorded to disk. If the unit is in E-E mode or recording, all 
outputs are live with the incoming signal. 

For any particular video input, there is an associated audio input selected as 
a default. You can change that default to another input utilizing the AUDIO 
INPUT MENU under SETUP. Refer to Chapter 2 for more information. 

1. GPI - For connection of the optional wired remote control (ACSS-0019-
01), the optional RS232C cable (CBLA-0113-01) or contact closure 
cable. The GPI plug accepts a 3.5mm TRS connector.

2. Front Panel HDD Port Loop Through - When patched to the To HDD 
port, this connector activates the front panel FireWire port for 
connection of external HDDs.

3. RS422 Control - This is the input connector for external RS422 control 
devices.

4. SDI Input - For connecting SDI input sources. The FS-2E provides the 
selection of channels 1 and 2 or 3 and 4 of the embedded SDI audio. 
Refer to the AUDIO INPUT > SDI > EMBEDDED sub-menu on Audio 
Input on page 59. The FS-2 does not have this capability.
SDI Output - For output to SDI devices. The FS-2E inserts two channels 
of audio into the SDI output stream. Only the FS-2E has this capability. 

5. Y/C Input - For connecting Y/C (S-Video) input sources. 
Y/C Output - For connecting to Y/C (S-Video) devices. 

6. Composite / Y Input - For connecting composite input sources or the Y 
signal for component input sources.
Composite / Y Output - For output to composite devices or the Y signal 
to component devices (select either composite or component form 
ANALOG SETTINGS in the SETUP menu).

7. Pb Input - For connecting the Pb signal from component input sources.
Pb Output - For output of the Pb signal to component devices.

1 2

20

3
4 5 6 7 8

16

9 10 11 12 13 14

1519 18 17
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8. Pr Input - For connecting the Pr signal from component input sources.
Pr Output - For output of the Pr signal to component devices

9. Sync Input - For connecting the Sync signal on non sync on green 
component sources.
Sync Output - For connecting the Sync signal to non sync on green 
component devices.

10. Timecode Input - For connecting external analog VITC timecode 
sources.
Timecode Output - For connection to external analog VITC timecode 
devices.

11. Reference Video - For reference video loop through.
To use this Reference Video input, select REF VIDEO from GENLOCK in 
the SETUP menu. If the loop-through jack is not connected, make sure 
the output is terminated using an external 75 ohm terminator.

12. AES/EBU Digital Audio Input and Output - For connecting AES/EBU 
input sources or output to AES/EBU devices. 

13. Stereo Audio Monitor Output - For connection of audio monitors. 
14. Balanced Analog Audio Input Channels 1 and 2 - For connecting 

balanced analog audio input sources.
Balanced Analog Audio Output Channels 1 and 2 - For output to 
balanced analog audio devices.

15. AC In - Use the power cord supplied to connect to the power outlet. 
The power module contains a protective fuse. Refer to Replacing the 
Power Module Fuse on page 15 for more information. 

16. Video Monitor Output - For connection to a video monitor (composite).   
Use this connection to view the On Screen Display.

17. DV I/O 1 and DV I/O 2 - For connection of DV video devices. These two 
ports are used to pass through the DV signal. The FS-2/2E does not 
support multiple DV inputs.

18. To HDD - For connecting external FireWire 400 disk drives to the FS-2/
2E. Use the FS-2/2E's HDD Bypass function with this port. When a 
connection is made with Front Panel HDD Port Loop Through, it allows 
the front panel FireWire connector to be used for connection of 
external FireWire HDDs.

19. To Computer - For connecting the FS-2/2E to a computer's FireWire 
400 port. It allows any disk drives connected to the FS-2/2E to mount 
to the computer.

20. Ethernet 10/100 BaseT - For connecting FS-2/2E to a network or 
computers for small file exchange, telnet, or web control. (The web 
control functionality is only available for the FS-2E or the FS-2 with the 
2.0 upgrade.) 
FS-2/2E Studio DTE Disk Recorder User Guide
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1.9 Setting Up the FS-2/2E

This section explains how to set up the FS-2/2E for use. Refer to the illustration 
below and perform the steps on the following page.

 

External VTR
Record OutputCamcorder

Video Source

Monitor
Display Output

Speakers
Audio Output

Playback VTR
Video Source

FS-2/2E Rear Panel
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To set up the FS-2/2E, do the following:
1. Plug in the power cord.
2. Connect a Video input device.
3. Connect an Audio source (if desired).
4. Connect a Monitor if desired.
5. Connect Speakers or Headset (to monitor the audio) if desired.
6. Connect a Tape Drive if desired.
7. Connect a Time Code Generator if desired.
8. Connect an External Control Device (RS422) if desired.
9. Connect a Reference Video signal if desired.

1.9.1 Formatting the Drive
Use this procedure to format the FS-2/2E internal or connected external 
disk drives when not yet formatted.

1. From the Utilities menu, select FORMAT DISK as shown below.
When you make this selection, the following screen appears:

2. Select between volumes by pressing the XX| and |WW buttons. 
• When you select the volume and press YES, the following screen 

appears:

• When you select YES, a message indicating that the formatting is 
progressing appears.

3. Press EXIT to return to the menu screen. 

WARNING: FORMAT ERASES ALL DATA ON THE DISK 
DRIVE!

FORMAT DISK

VOLUME 1?

SIZE       115 Gig 

FREE       540 Min 

EXIT      YES NO

FORMAT WILL

ERASE ALL DATA!!

CONTINUE  

FORMAT VOL 1? 

EXIT      YES NO
FS-2/2E Studio DTE Disk Recorder User Guide
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1.9.2 Setting the Time and Date
Before using the FS-2/2E, use this procedure to set the time and date.

1. Select the Setup Menu.
2. Select SET DATE & TIME. The following screen appears.

3. Select SET DATE or SET TIME and press SEL to open the sub menu as 
shown below.

4. Scroll from value to value using the FORWARD and BACK index 
buttons.

5. Press T and S to scroll through digits in the value. 
6. Press EXIT to return to the menu screen. 

Regardless of the display, the file name always remains YYYYMMDD-
HHMMSS.xxx (Year-Month-Date-Hour-Minute-Second).

SET DATE   X

SET TIME   X

 

 

EXIT            SEL   T

SYSTEM DATE

10/01/07

MM/DD/YY  

|WW &  XX|  

MOVES CURSOR

EXIT             S   S

SYSTEM TIME

16:21:13

Hh:Mm:Ss  

|WW &  XX|  

MOVES CURSOR

EXIT             S   S
E Studio DTE Disk Recorder User Guide     
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1.10Replacing the Power Module Fuse

The power module of the FS-2/2E contains a protective fuse. 

To replace the fuse do the following:
1. Turn off the FS-2/2E.
2. Locate the power module on the rear of the unit. It is indicated as AC In.
3. Detach the power cord from the power module.
4. Locate the small recess on the top of the power module above the power 

switch.
5. Use a small tipped standard screwdriver to pop open the fuse door.
6. Once open, slide the white fuse carrier out of the unit.
7. Replace the fuse with a 1.6 amp 250V slow blow fuse.
8. Reassemble the fuse carrier and slide it back into the unit.
9. Replace the fuse box door.
10. Re-attach the power cord. 
FS-2/2E Studio DTE Disk Recorder User Guide
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Chapter 2

FS-2/2E Functions
This chapter contains the following sections:
Edit/Utility/Input Buttons page 17
LCD Menu Soft Keys page 22
Transport Control Keys page 23
LCD Display page 26
FS-2/2E Menus and Functions page 30

2.1 Edit/Utility/Input Buttons

To the right of the hard disk drive is a bank of 15 buttons as shown below.

• The first row contains five buttons that are Edit functions keys. 
• The second row consists of five buttons that are Utility function keys. 
• The third row has five buttons that are Input buttons.

Edit Function Keys

Utility Function Keys

Input Source Selection Keys
FS-2/2E Studio DTE Disk Recorder User Guide
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2.1.1 Edit Function Keys

2.1.1.1 MARK IN - Mark In Key

Use the MARK IN key to mark a particular frame as a starting point 
when creating a clip for a playlist. Refer to Playlist Menu on page 
44 of this user guide for more information about Playlists.

2.1.1.2 MARK OUT - Mark Out Key

Use the MARK OUT key to mark a particular frame as an ending 
point when creating a clip for a playlist.

2.1.1.3 PLAYLIST – Add to Playlist key

Press this key during stop or play to add a current clip to the 
playlist.

Once In and Out points have been selected, press this key to add 
selected clips to the playlist.

2.1.1.4 KEEPER - Keeper Key

By pressing the KEEPER key during a recording, you can mark 
each clip into the KEEPER folder on disk. 

To add all KEEPER clips to the KEEPER folder on the disk drive, 
select UTILITIES > ORGANIZE CLIP from the FS-2/2E menu.

It is only possible to mark In and Out Points during playback.

Once the In and Out Points are selected, press the PLAYLIST key. 
The In and Out key lights will turn off. You are then free to add more clips 
to the playlist by again selecting In and Out points. When finished, go to 
the PLAYLIST menu under SETUP.
E Studio DTE Disk Recorder User Guide          
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2.1.1.5 FOLDER - Folder Key

By pressing the Folder key during a recording, you can mark each 
clip into particular pre-named folders on disk (up to 10 folders can 
be prenamed). Default names for the folders are 0 through 9. Refer 
to How to Mark Scenes on page 95 of this user guide to set up 
Scene Marking folders). 

By repeatedly pressing the FOLDER key, you can scroll though the 
available folders. You can also assign clips to folders using the 
numeric keypad on the optional remote control units. The current 
clip can be marked during recording, playback or in stop mode. 
Once selected, the clip is marked for placement into that particular 
folder. 

To add all marked clips to their respective folders on the disk 
drive, select UTILITIES > ORGANIZE CLIP from the FS-2/2E menu.

For more information on scene marking, refer to How to Mark 
Scenes on page 95 of this user guide.

If the FOLDER key is lit during playback, the 
FS-2/2E PLAY FROM mode is set to FOLDER.
FS-2/2E Studio DTE Disk Recorder User Guide
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2.1.2 Utility Function Keys

2.1.2.1 OSD - (On Screen Display)

Press this key to enable on screen display on the monitor output 
(composite). When off, the key will not light.

2.1.2.2 HDD – Hard Disk Drive Bypass Key

Press this key to immediately open the HDD Bypass confirm 
screen as described in the HDD Bypass section of the Menu. For 
more information, refer to HDD Bypass on page 50

2.1.2.3 LOCK – Keypad Lock Key

This key turns lock on or off. When the key is lit, the keypad is 
locked. When off, it is not locked.

2.1.2.4 REMOTE – Remote Key

When you press this key, the FS-2/2E goes directly to the 
REMOTE mode as described under the Control Modes menu. The 
key lights in Local mode. When in the FS-2/2E is in remote mode, 
you cannot use front panel keys for operation.

Another press exits REMOTE mode and the backlight turns off.

2.1.2.5 E-E – Electronic to Electronic Key

When you press this key, the selected input is passed on to all 
outputs on the FS-2/2E. The E-E mode is only active when the 
FS-2/2E is in STOP mode.
E Studio DTE Disk Recorder User Guide          
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2.1.3 Input Source Selection Keys

In all cases, when selected, the key lights. When selecting CMPST, Y/C, or 
CMPNT and there is no video source available, this light flashes several 
times and then the FS-2/2E returns to the original input selection. Switching 
is not seamless. You cannot change inputs while in record mode. 

2.1.3.1 CMPST – Composite Video Source Input Key

Press this key to select composite video as the input source. If 
there is no video source available when this button is pressed, the 
light flashes several times and then the FS-2/2E returns to the 
original video selection.

The default audio link is balanced analog audio. You can also 
select AES/EBU audio as the input link in the SETUP > AUDIO 
INPUT menu. 

2.1.3.2 Y/C – S-Video

Press this key to select S-Video (Y/C) as the input source. If there is 
no video source available when this button is pressed, the light 
flashes several times and then the FS-2/2E returns to the original 
video selection.

The default audio link is balanced analog audio. You can also 
select AES/EBU audio as the input link in the SETUP > AUDIO 
INPUT menu.

2.1.3.3 CMPNT – Component Video Source Input Key

Press this key to select Component video (Y, R-Y, B-Y) as the input 
source. If there is no video source available when this button is 
pressed, the light flashes several times and then the FS-2/2E 
returns to the original video selection.

The default audio link is balanced analog audio. You can also 
select AES/EBU audio as the input link in the SETUP > AUDIO 
INPUT menu.
FS-2/2E Studio DTE Disk Recorder User Guide
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2.1.3.4 SDI Serial Digital Video Source Input Key

Press this key to select SDI video (SMPTE 259M) as the input 
source. 

The default audio link is embedded AES/EBU digital audio in the 
stream. You can also select either balanced analog audio or 
separate AES/EBU audio as the input link in the SETUP > AUDIO 
INPUT menu. 

The FS-2E provides the option to select either channels 1 and 2 or 
3 and 4 of the embedded audio of the SDI stream. Refer to the 
SETUP > AUDIO INPUT > SDI > EMBEDDED sub-menu on page 59.

2.1.3.5 DV Video Source Input Key

Press this key to select DV video (25Mb/s) as the input source. 

The default audio link is embedded 2-channel digital audio in the 
stream. You can also select either balanced analog audio or AES/
EBU audio as the input link in the SETUP > AUDIO INPUT menu.

2.2 LCD Menu Soft Keys

The three keys directly below the FS-2/2E LCD display are soft keys for navigating 
and selecting items in the FS-2/2E menu.

These keys are also used for selecting different display modes. They are called soft 
because their function changes depending upon what is displayed on the LCD 
above the particular key.

Using the Right Soft Key to Scroll
In some cases when navigating the FS-2/2E menus, you can use the right soft key to scroll 
down through the menu. To scroll up, just hold down the SHIFT key as well as the right soft 
key.
E Studio DTE Disk Recorder User Guide          
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2.3 Transport Control Keys

This set of buttons controls playback and record functions of the FS-2/2E. These 
functions include play, reverse play, fast forward, fast rewind, forward frame, back 
frame, next track, previous track, stop, and record. This area also features hot keys 
for changing, controlling, and navigating the FS-2/2E menu system. Each of these 
keys is described below as shown in order left to right, top to bottom. 

2.3.1 MENU 
Press this key to launch the FS-2/2E menu system. Once pressed, the Menu 
screen appears on the FS-2/2E LCD and the button lights. If you press the 
MENU key while in a particular screen in the menu system, that menu is 
marked and the MENU key lights. You can then EXIT the menu and 
perform other functions. If you press the MENU key at anytime, you will 
return to the marked Menu (except if you are in REC mode).

2.3.2 |WW Back Index 
Press this key to return to the beginning of the current clip if in playback 
mode. Press it twice to return to the previous clip during playback. In Stop 
mode press it to return to the beginning of the previous clip. If you press 
SHIFT and Back Index, the previous disk drive is selected.

Stop Record

Play

Previous

Rewind Fast
Forward

Next 
Frame

Menu Next Tack
FS-2/2E Studio DTE Disk Recorder User Guide
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2.3.3 XX| Forward Index 
Press this key to skip forward to the next sequential clip for playback. 

• To skip ahead 10 clips per increment, holding down Forward Index.
• To select the next disk drive, press SHIFT and then Forward Index.

2.3.4 � Stop  
Press this key to Stop the selected mode and return the FS-/2E to Pause. 
Press it again to put the FS-2/2E into STOP (standby with menu screen). 
The splash screen is the first frame of the selected clip when you select 
SETUP > STOP OUTPUT > CLIP PREVIEW. When the FS-2/2E is in Stop 
mode, the key lights.

2.3.5 X Play 
Press this key to start playback of the selected clip. If you press the SHIFT 
and PLAY keys, the FS-2/2E immediately goes into Reverse Play mode. 

2.3.6 z Record Key 
Press this key once when the FS-2/2E is in STOP mode and the FS-2/2E 
goes into REC-PAUSE. The REC button flashes. Press it again to start 
recording. If you press REC during a recording, the current clip is closed 
and a new clip is created without dropping any frames. This key is the only 
key that is RED on the front panel.

If you press REC and SHIFT simultaneously, the FS-2/2E captures a single 
frame of video. In a particular session, all single frames of video are saved 
as part of the same clip on disk.

2.3.7 SHIFT 
Use the SHIFT key to give particular keys a secondary functionality. When 
you press it, the SHIFT key lights and remains in SHIFT mode until the 
button is released. The SHIFT mode of particular keys is listed below that 
key or displayed on the FS-2/2E LCD.

2.3.8 WW Back Search 
Press the Back Search button to allow video to be played at different speeds 
(both slower and faster than real-time). Refer to the note under Forward 
Search Key for more information.
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2.3.9 XX Forward Search 
Press the Forward Search key to play video at different speeds (both slower 
and faster than real-time). 

For instance, if you are in 10X FF speed and you press the Back Search 
button once, you are in 2X FF mode. This also applies to backward search 
speeds. The default speed resolution is as follows (NTSC and PAL have 
slightly different multiples for both greater and less than 1X play speed):

• REVERSE: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still.
• FORWARD: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X

Forward Search and Reverse Search also have a “higher resolution” mode 
where more speeds are available as follows: 

• REVERSE: -30X, -25X, -18X, -15X, -12X, -10X, -8X, -5X, -4X, -3X, -2X, 
-1/30, -1/15, -1/10, -1/6, -1/5, -1/3,-1/2

• FORWARD: +30X, +25X, +18X, +15X, +12X, +10X, +8X, +5X, +4X, +3X, 
+2X, +1/30, +1/15, +1/10, +1/6, +1/5, +1/3, +1/2

This mode can be set in the SETUP > FF / RW HI RES menu in the FS-2/2E 
Setup menu. Once set, these speed resolutions become available when you 
press Back Search or Forward Search. 

Change Search Speed with FF Search and Back Search
Pressing the FF Search button multiple times results in increases in the search 
speed. This mode is bidirectional in forward X times normal search speed. Press the 
Back Search button to cause the FF speed to slow down by one step.
FS-2/2E Studio DTE Disk Recorder User Guide
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2.4 LCD Display

The FS-2/2E LCD screen displays different FS-2/2E modes and states. On boot up, 
the FS-2/2E displays the following screen: 

Depending on the connected disk drive, the FS-2/2E may or may not display 
Please Wait during boot up.

Once booted, if no disk drive is connected to the FS-2/2E (either through the 
internal slot or externally using the HDD I/O port), the following screen appears: 

Insert a drive into the front panel drive bay or connect a FireWire disk drive to the 
HDD I/O port. 

If you received a drive from Focus Enhancements, it should be configured and 
ready to use. If the message No Disk Detected appears, make sure the drive is inserted 
properly. 

If the message No Format Detected appears, you must partition and format the 
inserted drive before use. The FS-2/2E prompts you through the steps required to 
perform a format.

Warning: Formatting and Portioning Erases All Data On the Disk.

WELCOME

TO FS-2E

PLEASE WAIT

NO DISK

DETECTED

MENU
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Once ready for use, the FS-2/2E default menu screen appears as follows:

1. Play/Record Status Symbol 
This symbol displays a graphical representation of the current FS-2/2E state 
as follows:

� - STOP

X,W - Play or Reverse play

XX - Fast Forward search and speed

WW - Fast Back search and speed

z - Record and Record mode

|| - Pause

2. Record/Play Status Indicator 
In this space, the FS-2/2E displays a character that indicates what record or 
playback mode it is in. The characters displayed and their respective modes 
are listed in FS-2/2E LCD Display Modes on page 114 of this user guide.

3. Current System Status 
The current system status of the FS-2/2E is displayed in the top left corner of 
the LCD display. For instance, it displays whether the FS-2/2E is in record, 
play, stop, pause, fast search or slow motion modes.

4. Volume Number 
The volume or disk number of the current clip recording or playback session 
is displayed in the top right corner of the LCD display. For example, a display 
value of 2-014 identifies a track as being on volume 2.

Each symbol has multiple display modes. 
For a complete list, refer to FS-2/2E LCD Display Modes on page 26.

�      STOP         1-001

COUNTER

00:00:00:00

DISK 1 183 Min

FOLDER

MENU         DISP      SHFT

1

7

13

12

2 3 4 5

10

11

9

6

8
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5. Track or Clip Number 
The track number is displayed in the top right corner of the LCD Display. This 
is the current clip or track number being recorded or played back. For 
example, a display value of 2-014 identifies a track as being clip 14 on volume 
2.

6. Timecode/User Bit Display Mode 
This identifies the display mode for timecode or user bit values. Selections are:

• COUNTER - Counts frames during record or playback of the current clip 
only.

• REMAINING - Counts down the number of frames available (time) on a 
particular disk during a record session. In a playback session, this dis-
play shows the remaining time on the current clip.

• DV NTSC or PAL - Displays the external timecode value being generated 
by a camcorder or other device during a record session. Timecode mode 
has to be set to EXT TC for this function to operate (refer to TC Mode on 
page 60 of this user guide). In playback mode, this displays the embed-
ded DV timecode value in a particular track.

• USER BIT - Displays the set user bit value in a particular clip. A user bit 
value must be added for this to display (refer to TC Set on page 62 of this 
user guide).

• ABSOLUTE - Displays an absolute timecode value for the particular ses-
sion (sum of all COUNTER timecodes on connected volumes). This is 
primarily used when you set the FS-2/2E to AV/C mode and are con-
trolling it with an external FireWire device, such as a computer. 

• AUDIOMETER - Displays left and right levels in db. The scale indicates -
10db, -4db, and 0db. This display mode is only available for the FS-2E, or 
the FS-2 (with the 2.0 upgrade). The 2 lines on the menu appear similar to 
the following:

7. Timecode or User Bit Value 
Displays the timecode or user bit value of display mode selected as follows:

00:00:00:00 - Drop Frame 
00:00:00:00 - Non Drop Frame

The FS-2/2E Does Not Accept NDF TC Values in DF TC Mode.

      PLAY   1-001
          -10   -40  

            �  �� 
L
R          

DISK 1   530min

DISP SHFT
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8. Current Disk Volume 
Displays the current disk volume in relation to available space.

9. Available Space on Volume 
Displays the space in time available on the current volume, for example,

• DISK 1 183min - Current Disk time remaining is 183 minutes 
• NO DISK - No attached Disk

10. Folder Display 
In record or playback, this displays the particular folder a clip is in (if 
applicable). If playing an entire folder (PLAY FROM menu set to particular 
folder), it displays the folder name as follows: [FOLDER].

11. Soft Key One (MENU) Function Display 
Displays the current function related to Soft Key 1 (left key on the top row of 
buttons). You can use this key for opening the FS-2/2E Menu and also as a 
STOP key during a recording.

12. Soft Key Two (DISP) Function Display 
Displays current function of Soft Key 2 (middle key on the top row of 
buttons). This changes the TC display between COUNTER, REMAINING, DV TC 
(NTSC or PAL), USER BIT, and ABSOLUTE when in record or playback modes. 
For the FS-2E, or the FS-2 with the 2.0 upgrade, there is an additional 
AUDIOMETER display mode.

13. Soft Key Three (SHFT) Function Display 
Displays current function of Soft Key 3 (right key on the top row of buttons).
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2.5 FS-2/2E Menus and Functions

The FS-2/2E features a comprehensive menu system which allows a number of 
features to be initiated and setup. The menu system contains the following 
selections:

• RECORD MODE 
• NORMAL REC
• RETRO DISK
• RETRO CACHE
• LOOP RECORD
• STILL
• TIME LAPSE

• CONTROL MODE
• LOCAL (selections include: NORMAL, INDEX AT TC, INDEX AT SCENE)
• REMOTE
• AV/C (selections include NORMAL, INDEX AT TC, INDEX AT SCENE)
• SYNCRO SLAVE (selections include NEW FILE [for FS-2E, or FS-2 with 

2.0 upgrade only], SAME FILE [for FS-2E, or FS-2 with 2.0 upgrade 
only])

• PLAY MODE
• PLAY CLIP
• LOOP CLIP
• LOOP ALL
• PLAY ALL

• PLAY FROM MODE
• TRACK LIST
• PLAY LIST
• FOLDER LIST (selections include: NONE, KEEPER, 0, 1, 2, 3, 4, 5, 6, 7, 8, 9)

• PLAYLIST
• OPEN
• SAVE
• NEW 
• EDIT (selections include REMOVE CLIP, INSERT CLIP, and MOVE CLIP).
• VIEW
• DELETE LIST

• HDD BYPASS
• INTERNAL HDD
• RECORD FORMAT

• RAW DV
• AVI TYPE 1
• AVI TYPE 2
• CANOPUS AVI
• MATROX AVI
• QUICKTIME
E Studio DTE Disk Recorder User Guide          
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• AVID OMF
• PINNACLE
• 24P AVI TYPE 2 (for FS-2E, or FS-2 with 2.0 upgrade only)
• 24P QUICKTIME (for FS-2E, or FS-2 with 2.0 upgrade only)

• SETUP
• SET DATE & TIME (sub-menus include SET DATE, SET TIME)
• OS VERSION NO
• OS UPGRADE
• PAL/NTSC (selections include NTSC, PAL)
• RS422 REMOTE

• TYPE (selections include BVW-75, GENERIC)
• TC SOURCE (selections include ABS, DV, COUNTER)
• COMPOSITE (selections include BALANCED and AES/EBU)

• AUDIO INPUT
• COMPOSITE (selections include BALANCED and AES/EBU)
• Y/C (selections include BALANCED and AES/EBU) 
• COMPONENT (selections include BALANCED and AES/EBU) 
• SDI (selections include EMBEDDED, BALANCED, AES/EBU) 
• DV (selection is EMBEDDED)

• AUDIO IN LEVELS
• TC MODE

• EXT TC (selections include SELECTED INPUT, LTC) 
• REC RUN
• REGEN
• FREE RUN
• TC SET
• TC PRESET
• UB PRESET
• TC DELAY (FS-2E only)
• DROP/NON-DROP (sub-menus include DROP, NON-DROP)

• ON SCREEN DIS (sub-menus include ABS, TC, MENU, OFF)
• FF/RW HI RES (sub-menus include ENABLE, DISABLE)
• GPI PORT (sub-menus include DISABLE, PAUSE/UNPAUSE, INDEX/NEW 

FILE, REC SNAPSHOT) 
• BACKLIGHT (selections include ON, OFF, AUTO OFF)
• STOP OUTPUT (selections include GRAY, NO OUTPUT, CLIP PREVIEW, 

CUSTOM)
• AUDIO CORRECT (selections include OFF, MEDIUM, HIGH)
• PREFERENCES (selections include SAVE, RESTORE)
• FOLDER PREF (selections include SCENE MARK and AUTO MARK)
• ANALOG OUT (selections include COMPOSITE, COMPONENT)
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• NETWORK SETUP 
• IP SETTINGS (selections include DHCP, CUSTOM IP)
• USER/PASSWORD
• VIEW IP INFO
• SERVICES (selections include FTP [ENABLE/DISABLE], TELNET 

[ENABLE/DISABLE], WEB [ENABLE/DISABLE])
• GENLOCK (selections include SOURCE [REF VIDEO/FREERUN], SC PHASE, 

H PHASE)
• VIDEO OUT ADJ
• COMPOSITE Y/C (selections include HUE, SATURATION, BRIGHT-

NESS, CONTRAST, BLACKLEVEL, [0/7.5]) 
• COMPONENT (selections include Y, U, V) 

• COMPNT LEVEL 
• INPUT (selections include SMPTE, BETA, MII) 
• OUTPUT (selections include SMPTE, BETA, MII) 

• UTILITIES
• ORGANIZE PINN
• ORGANIZE CLIP
• ORGANIZE OMF
• DELETE CLIP
• FORMAT
• PARTITION
• REPAIR (selections include CHECKDISK, CURRENT CLIP)
• FILE NAME
• FACTORY RESET
• DIAGNOSTIC

Each of these selections is explained in this chapter.

To enter the FS-2/2E main menu, press the MENU key or soft key 1 (MENU) while 
in STOP mode. The following menu screen appears: 

2.5.1 Menu Items
The four line list indicates the currently highlighted menu item. Push soft 
key 3 (under the T symbol) to see more selections. To scroll up through the 
menu, press SHIFT + soft key 3.

RECORD MODE X

CONTROL MODE X

PLAY MODE X

PLAY FROM X

  EXIT SEL     T
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2.5.2 Sub-Menu Available
The X symbol at the end of a line indicates a menu item that has a sub-
menu available. Press the SEL soft key, to display the sub-menu.

2.5.3 Soft Keys
• EXIT -- Press EXIT to return to the 

FS-2/2E main menu screen.
• SEL -- Press SEL to select the current menu item. If a sub-menu is 

available, it will open. 
• Scroll Arrow -- The T or S symbol allows you to scroll up or down 

through menu items. 

2.5.4 Record Menu
The FS-2/2E RECORD MENU allows you to enable different record 
functions. 

• Select the mode. by pressing SEL to open the sub menu. 
• Press EXIT to exit back to the menu screen. 

Once you select a particular mode in the Record Mode menu, the FS-2/2E 
remains in that mode until a different mode is selected.

Available items in the RECORD MENU are:
• NORMAL REC 
• RETRO DISK 
• RETRO CACHE
• LOOP RECORD
• STILL
• TIME LAPSE 

2.5.4.1 Normal Record

This is the standard and default record mode. When you press 
REC, the FS-2/2E begins standard recording. Press the REC once 
to put the FS-2/2E into REC PAUSE mode. Press it again to put the 
FS-2/2E into RECORD mode. 

No Space Left Message
When an inserted or attached HDD is nearly full, in some record sessions, 
the HDD time remaining may display 001min remaining. If you press 
RECORD, the FS-2/2E sometimes displays NO SPACE LEFT. Focus 
Enhancements advises that when a disk drive is close to being full, you 
make sure other disk drives are readily available in order to avoid lost 
footage
FS-2/2E Studio DTE Disk Recorder User Guide
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Press STOP once to pause your recording. To stop the recording 
session entirely, press STOP once again. Use the REC button to 
restart the recording.

2.5.4.2 Retro Disk 

RETRO DISK Record constantly buffers video in a loop to a 
determined amount of space on the hard-disk drive so that when 
record is triggered, a retro time period can be added to the 
beginning of any clip. You can select the RETRO DISK value to 
close the available disk drive space.

1. Set RETRO TIME by pressing the S and T buttons. Time is 
selectable in one minute increments. 

2. Hold the button for more than 3 seconds to allow numbers to 
increase by 10 times. 

3. Press EXIT to return to the RECORD.

Press the REC key when in RETRO DISK mode to put the FS-2/2E 
into a RETRO DISK state (the FS-2/2E's REC button flashes as if in 
REC-PAUSE state). The FS-2/2E is actually recording in this state, 
but until you press the REC key a second time, the video records 
over itself in a continuous loop. RETRO DISK always keeps at 
least the selected amount of time in a series of one minute clips. 
For instance, if you set the RETRO DISK value to 3 minutes, the 
FS-2 always has 3 minutes (made up of three, one (1) minute clips) 
of video saved to disk. As the recording goes past the 3 minute 
point, a fourth clip is created. Once that clip reaches one minute, 
the oldest of the previous 3 clips is deleted. Another fourth clip is 
then created. 

If you select a RETRO session that is 60 minutes or greater, instead 
of one minute clips, the FS-2/2E creates 9 minute, 13 second clips 
(2GB clips on disk). The functionality of RETRO DISK remains the 
same. The larger file size prevents the FS-2/2E from reaching its 
999 track limitation for very long RETRO records. 

RETRO DISK

HDD AVAIL: 

183 Min

RETRO TIME:

 15 Min

 EXIT  S   T
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Due to larger files sizes, the maximum amount of drive space 
available is decreased to accommodate the last recording in a 
session. For instance, if you have 90 minutes of disk space 
remaining, after you set RETRO record to less than 60 minutes, 
the available space changes to 88 minutes of available disk space. 

If you set RETRO time to 88 minutes, the recording will be made 
up of about nine and a half 9 minute, 13 second clips. There must 
be space available in this situation in order to record the final clip 
which eventually will write over clip 1. This ensures that at any 
given time, at least 88 minutes of video exists after a complete 
RETRO DISK record loop. 

Once RETRO DISK time is set, you can exit the Menus and return 
to the Main Screen. An L appears next to the record symbol on the 
FS-2/2E's display. Press the REC key once to put the FS-2/2E 
immediately into RETRO DISK RECORD. Clips are being recorded 
to disk for X number of minutes in one or nine minute increments 
(each as a separate track).

The REC button flashes (as when the unit is in pause). When you 
press the REC key, the FS-2/2E leaves RETRO DISK mode and 
goes into standard record.

All one minute tracks in the recorded loop sequence appear and 
are saved as their own tracks on disk (for example, 1-001, 1-002, 1-
003, and so on) except for the recording that was in progress, 
which takes on the characteristics of a standard track. At this 
stage, the FS-2/2E is in standard record mode and the L on the 
display disappears. No frames are lost across tracks during the 
record session. 

Once paused, the unit returns to RETRO DISK record mode (the L 
reappears in the LCD and viewfinder) for further RETRO 
recordings or until it is disabled in the RETRO DISK screen.

RETRO DISK can be used in LOCAL and SYNCRO SLAVE record 
control modes. 

Minimum Disk Space Requirements 
The FS-2/2E must always have at least one minute of disk space (under 
60 minutes) or 9 minutes, 13 seconds of disk space (when the RETRO 
DISK value is set to greater than 60 minutes) remaining in addition to the 
RETRO DISK value, in order to function correctly. For instance, it is not 
possible to set a RETRO DISK value of one minute if only one minute of 
disk space remains.

WARNING: Make certain that the FS-2/2E is in STOP mode 
before removing the disk drive from the system. 
Do Not Attempt to Remove the drive when the FS-2/2E is in 
REC or REC-PAUSE mode.
FS-2/2E Studio DTE Disk Recorder User Guide
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2.5.4.3 Retro Cache 

RETRO CACHE Record constantly caches your video in a loop up 
to a 10 second data buffer. In this way, when the record is begun, a 
retro time period is added to the beginning of any clip. 

Pressing the REC key when in RETRO CACHE mode puts the FS-
2/2E into a RETRO CACHE state (the tally light on the FS-2/2E 
flashes as if in PAUSE state). The FS-2/2E is actually recording in 
this state, but until you press the REC key a second time, the video 
records over itself in a continuous loop. It is much the same as 
RETRO DISK recording, except that it utilizes a data buffer 
separate to the disk drive to cache video. 

RETRO CACHE is also accurate down to the frame instead of the 
1 minute clips used in RETRO DISK. Once a RETRO CACHE 
value is set, pressing the REC key once puts the FS-2/2E 
immediately into RETRO CACHE Record. A C now appears next to 
the record symbol on the FS-2/2E's display. 

Video is being recorded to the FS-2/2E cache. The REC button 
flashes (as if the unit is in pause). When you press the REC key, 
the FS-2/2E exits the RETRO CACHE Record mode and goes into 
standard record (the C on the display disappears). 

Any clip recorded in this mode has the contents of the cache 
added to the beginning of the clip. 

Once paused, the unit returns to the RETRO CACHE record mode 
again (the C reappears in the LCD) for further RETRO CACHE 
recordings or until it is disabled in the RETRO CACHE by setting 
the RETRO CACHE time to zero seconds.

RETRO CACHE record can be used in LOCAL and SYNCRO 
SLAVE record control modes.

2.5.4.4 Loop Record

When LOOP RECORD is selected after recording has begun, 
video is recorded to available disk space. Clips are recorded to 
disk continuously in one-minute clips (up to 60 minutes), or 9 
minute clips (for loops over 60 minutes, 2GB files).

RETRO CACHE

CACHE: 10 sec
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When the disk capacity’s record time is reached, an additional 
one-minute (or 2GB) segment is created. After this clip is 
complete, the oldest one-minute clip (or 2GB segment) is recorded 
over, followed by each sequential oldest clip.

When you press STOP during a record session, recording stops 
and clips in the current LOOP RECORD session are saved to disk. 
They are also saved in a single folder.

2.5.4.5 Still

When you select STILL when REC has begun, a single frame is 
grabbed.

You can grab a still quickly by pressing SHIFT and REC on the 
front panel when you are in any record mode.

Use STILL with LOCAL and SYNCRO SLAVE record control 
modes. If STILL is the record mode when power is cut to the unit 
or it is turned off, and then rebooted, the FS-2/2E goes to 
NORMAL REC mode.

2.5.4.6 Time Lapse 

You can select an interval of up to twenty-four hours. The interval 
is the period of time between the FS-2/2E capture of a single 
frame of video (a value of 00:00:00:00 means no frames will be 
recorded). 

1. Set REC INTERVAL by pressing the TIME S and T buttons. 
Select the time in frames (up to 30 for NTSC or 25 for PAL), 
then seconds (up to 59), then minutes up to 59, then hours up 
to 23.

2. Use |WW and XX| keys to scroll between values.
3. Press EXIT to return to the menu screen.

Loop Record Only Works with One Disk Drive.

TIME LAPSE

00:00:00:00

|WW & XX|
MOVES CURSOR

 EXIT S T
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2.5.5 Control Mode Menu

1. Select the Control mode. The highlighted mode is the current mode 
after exit.

2. Press EXIT to return to the menu screen.

Control Mode has the following functions:
• LOCAL
• REMOTE
• AV/C
• SYNCRO SLAVE 

2.5.5.1 Local

Select these options to control the FS-2/2E from the front panel 
buttons only. You can also control the FS-2/2E with the optional 
wired remote control unit (ACSS-0019-01). This can be purchased 
at the Focus Enhancements online store, 
https://www.focusinfo.com/webstore/webstore.asp.

This sub-menu contains the following selections:

• Normal Mode - default - In this mode, recordings are 
captured to a single base file until STOP is triggered, or the 
nine minute file size limit is reached.

• Index at TC - In this mode, recordings are continuous until a 
break in the incoming timecode stream is detected, or the 
nine minute file size limit is reached. At that time, a new file 
is automatically created. No frames are lost during the 
transition to a new clip.

LOCAL

REMOTE

AV/C
SYNCRO SLAVE

 EXIT SEL

X

X
X

T

NORMAL

INDEX AT TC

INDEX AT SCENE
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• Index at Scene - In this mode, recordings are continuous 
until a scene break is detected in the incoming video stream, 
or the nine minute file size limit is reached. At that time, a 
new file is automatically created within one second of the 
scene change. No frames are lost during the transition to a 
new clip..

2.5.5.2 Remote

Select this function to control the FS-2/2E by an external device 
through the RS-422 port. The FS-2/2E takes on the characteristics 
of a VTR as setup in the RS422 menu screen in the SETUP menu. 
You cannot use the FS-2/2E front panel controls in this mode.

The FS-2/2E has a menu item that allows the FS-2/2E to appear to 
external controllers as a Sony BVW-75 BetaSP VTR when in 
Remote RS422 mode. It also has a generic RS422 mode.

In remote, you can also slave an FS-2/2E to another device (such 
as a Betacam or other non-DV deck) using the RS422 port.

The Index at Scene option watches the DV stream for an index 
marker that is recorded to tape when a new scene, or record 
session starts. It depends upon the camcorder when this index is 
recorded to tape. Some camcorders record the index at every 
scene, or when the camera is placed in and out of record pause. 
Other cameras, only record the index marker at the beginning of 
every record session; in other words, the camera needs to be 
placed into STOP or powered-off between indices. Refer to your 
camcorder's manual for more information.

FS-2/2E Does Not Support All BVW-75 Control Functions
This mode is only for greater compatibility with existing control systems. 
Refer to Supported RS-422 Commands on page 116 for a listing of 
RS422 supported commands.
FS-2/2E Studio DTE Disk Recorder User Guide
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2.5.5.3 AV/C

Use these settings in PLAYBACK and other situations where the 
FS-2/2E is controlled by an external FireWire device (such as a DV 
NLE system).

There three options in this sub-menu: 

• Normal Mode - default - In this mode, recordings are 
captured to a single base file until STOP is triggered, or the 
nine minute file size limit is reached.

• Index at TC - In this mode, recordings are continuous until a 
break in the incoming timecode stream is detected, or the 
nine minute file size limit is reached. At that time, a new file 
is automatically created. No frames are lost during the 
transition to a new clip.

• Index at Scene - In this mode, recordings are continuous 
until a scene break is detected in the incoming video stream, 
or the nine minute file size limit is reached. At that time, a 
new file is automatically created within one second of the 
scene change. No frames are lost during the transition to a 
new clip. Refer to the note under Local mode regarding 
index markers.

AV/C does not function completely with all NLE systems. 
Contact Focus Enhancements technical support for more information.

NORMAL

INDEX AT TC

INDEX AT SCENE
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2.5.5.4 Syncro Slave

The FS-2E and the FS-2 (with the 2.0 upgrade), has two settings in 
Syncro Slave:

• NEW FILE - default - This setting, and the FS-2E is triggered 
to stop recording from the camcorder, the current file is 
closed and a new file is opened ready for the next recording. 

• SAME FILE - This option appends the new recording onto the 
same file. This significantly cuts down on the number of files 
created and is ideal for many applications.

In SYNCRO SLAVE mode, a camcorder and the FS-2/2E share the 
same record function and the FS-2/2E is slaved to the camcorder. 
Once it is set and you exit the CONTROL menu, they return to the 
default menu screen. The FS-2/2E also immediately enters REC 
PAUSE mode and a Y appears next to the record symbol on the FS-
2/2E interface. 
All recording is controlled by the camcorder exclusively. Every 
time you press the camcorder’s REC button, the FS-2/2E goes into 
the selected RECORD mode. Each time you start recording on 
your camcorder, a new track is created on disk.
When used with RETRO DISK or RETRO CACHE functions, as 
soon as SYNCRO SLAVE is set, the camcorder begins filling up the 
selected retro record buffer. Press the REC button on the 
camcorder and the contents of the retro buffer are appended to the 
start of your clip. 
The FS-2/2E buttons (other than MENU) are locked out when in 
this mode. It is also not possible to use the optional FS-2/2E 
remote control units. You must exit SYNCRO SLAVE by entering 
the CONTROL menu by pressing the MENU button when on the 
FS-2/2E main menu. If the camcorder is set to VTR mode, the FS-
2/2E’s control panel becomes active in order to allow playback. 
If a tape ends while using SYNCRO SLAVE mode, the FS-2/2E 
continues to record.
At this point, to stop a recording, push the FS-2/2E STOP button 
twice.

NEW FILE

SAME FILE

 EXIT          S       T
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2.5.6 Play Mode Menu

1. Select the mode. The highlighted mode is the current mode after exit.
2. Press EXIT to return to the menu screen. The default mode is PLAY 

CLIP.

2.5.6.1 Play Clip

For this function, the FS-2/2E plays the selected clip from start to 
finish when you press the PLAY button. At the end of the selected 
clip, the FS-2/2E pauses.

2.5.6.2 Loop Clip

For this function, the FS-2/2E plays the selected clip from start to 
finish. Immediately after completing the clip, the FS-2/2E begins 
playing the clip again without a pause. It plays this clip until 
stopped.

2.5.6.3 Loop All

For this function, the FS-2/2E plays the entire contents of the disk 
(all clips) in order from start to finish. At the end of the last clip, 
the FS-2/2E begins to play from the beginning of the first clip 
again without a pause. It plays these clips until stopped.

2.5.6.4 Play All

For this function, the FS-2/2E plays the entire contents of the disk 
(all clips) in order from start to finish. At the end of the last clip, 
the FS-2/2E pauses.

PLAY CLIP

LOOP CLIP

LOOP ALL
PLAY ALL
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2.5.7 Play From Mode Menu

This selection allows you to select the playback list used in play mode. 
There are three options available.

1. Select the mode. The highlighted mode is the current mode after exit.
2. Press SEL for the highlighted menu item to open the sub-menu. When 

you exit the menu, the last menu item is the current mode.
3. Scroll from value to value using the FORWARD and BACK INDEX 

buttons.
4. Press Tand S to scroll through digits in the value. 
5. Press EXIT to return to the menu screen. 

2.5.7.1 Track List

When you select this setting, all clips on attached disk drives are 
played back sequentially based on the order of their base file 
name regardless of whether they have been marked in the 
KEEPER or SCENE MARKING folders. If Track List is selected, all 
PLAY MODES relate to all clips on the connected disk drives.

2.5.7.2 Play List

This selection plays the items in the current playlist.

2.5.7.3 Folder List

When you select this setting, you can play back clips only from a 
selected folder. The highlighted folder is the selected folder after 
exiting. When selecting FOLDER, all PLAY modes relate only to 
clips in the selected folder.

When the FS-2/2E PLAY menu is set to TRACKLIST the name of 
the current folder appears without brackets on the LCD display 
(for example, 2 SCENE 2). 

When the PLAY FROM menu is set to FOLDERS, the name of the 
current folder appears in brackets on the LCD display (for 
example, 2 <SCENE 2>).

TRACK LIST

PLAY LIST

FOLDER LIST

 EXIT S

X

T
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2.5.8 Playlist Menu

The Playlist menu options are:
• OPEN 
• SAVE 
• NEW 
• EDIT
• VIEW 
• DELETE 

The FS-2/2E playlist feature allows you to playback clips in a custom, user-
defined order. 

Playlists are created using the FS-2/2E front panel. You can mark in and out 
play points on clips. Multiple playlists can be opened, saved and edited at 
any time. Use the PLAY FROM menu to select the playlist to playback. Use 
the PLAYLIST menu selection to modify, open or save playlists.

Playlists can be named with an 8 character/number name (such as 04-05-04 
or PROMO2). 

A playlist can consist of multiple sequences with whole or portions of 
recorded clips. Each sequence gets a number in the playlist starting with 
001. The corresponding track number of the clip sequence is also displayed 
(for example, 1-005 is a sequence from track five on volume 1). 

Select the mode from the list. 
1. Press SEL when highlighting a menu item to open the sub-menu. 

When you exit the menu, the last menu item is the current mode.
2. Press EXIT to return to the menu screen. These settings are saved on 

power down.

OPEN

SAVE

NEW
EDIT

  EXIT  SEL

X

X

X

S
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2.5.8.1 Open

Open allows you to open a playlist on disk. Do this as follows:

1. In the PLAYLIST menu, select the OPEN option. 
A display similar to the following appears. 

2. Once the sub menu is opened, select the desired playlist 
from the list. A screen similar to the following appears. 

3. Once selected, you can VIEW or PLAY the playlist. 
If you select the PLAY option, EXIT to the main display and 
press PLAY. The PLAYLIST button lights and playback will 
be from the selected Playlist only. 
You can also play from a playlist using the PLAY FROM > 
PLAYLIST menu. 

Only one playlist can be opened at a time.

Save Changes Before Opening Another Playlist
If you open a playlist without saving changes to a playlist using the SAVE 
menu option, the changes are lost.

03-20-20

06-20-20

03-25-20

03-30-20

  EXIT SEL S

03-20-20

 EXIT

PLAY LIST

OPENED

VIEW PLAY
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2.5.8.2 Save

When a playlist has been created or modified, use the SAVE 
option to write it to disk. 

If you modify a playlist, upon exiting, the SAVE function 
automatically appears. 

If you have made modifications and wish to save them as a new 
playlist, modify the file name prior to saving it.

Select NEXT and a display similar to the following appears.

Select YES or NO.

2.5.8.3 New

Even if a playlist is open, you can begin creating a new one. If you 
create a new playlist without saving changes using the SAVE 
menu option, the changes are lost.

2.5.8.4 Edit

The edit menu allows you to modify an existing playlist. 

The selected playlist must be opened in order to edit. EDIT allows 
you to REMOVE, INSERT or MOVE clips within a playlist. 

SAVE PLAYLIST?

02-20-20

  NEXT T S

CONTINUE SAVE?

02-20-20

BACK YES NO
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2.5.8.4.1 REMOVE a Clip

To remove a clip, use the following steps:
1. Select EDIT from the PLAYLIST menu and then 

REMOVE CLIP. You are given a list of clips in the 
open playlist. (If no clips are in the playlist, the 
message PLAYLIST EMPTY appears.) 

2. Select the clip you wish to remove and then press 
NEXT.

3. You will be asked again if you are sure you want 
to delete the item from the playlist. 

2.5.8.4.2 INSERT a Clip

The INSERT CLIP option allows you to insert a clip in 
an existing playlist. A playlist must be opened and 
you must have marked in and out points for the clip 
you would like to insert before continuing. 

1. From the PLAYLIST menu, select EDIT > INSERT 
CLIP. The selected clip number and its details will 
be listed. 

2. Press NEXT. 

0001

0002

0003

0004

S

1-001

1-004

1-001

1-003

NEXT T

DELETE ITEM?

HDD:

CLIP:
00:00:01:23

00:00:02:00

  EXIT

01

0001

1-003

YES NO
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3. Select between inserting at the BEGIN, END or 
CUSTOM (user-specified) part of playlist. Once 
you have selected your choice, the updated 
playlist is displayed. 

2.5.8.4.3 MOVE a Clip

The MOVE CLIP option allows you to move a clip 
within an existing playlist. To move a clip, use the 
following steps:

1. Select MOVE CLIP from the PLAYLIST > EDIT 
menu. 

2. Once selected, scroll to the clip you wish to move. 

3. Press NEXT. The clip information displays. 

4. Select NEXT. You can move the clip to the BEGIN, 
END or CUSTOM (user-specified) part of the 
playlist. 

5. Press NEXT. The updated playlist is displayed.

INSERT ITEM

IN CLIP  1-001

OUT CLIP 1-001

1  00:00:01:23

0  00:00:02:00

EXIT NEXT

0001

0002

0003

0004

EXIT

1-001

1-004

1-001

1-003

NEXT T

HDD:

CLIP:

00:00:01:23

00:00:02:00

EXIT

CLIP INFO

01

0001

NEXT BACK
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2.5.8.5 View 

The VIEW option allows you to view the track information of an 
OPEN playlist. A playlist must be opened in order to view. 

1. Select VIEW from the PLAYLIST > EDIT menu. 

2. Scroll to the desired clip, then select NEXT. The clip 
information is displayed.

2.5.8.6 Delete List 

The DELETE LIST option allows you to delete an entire playlist. 

1. Select DELETE LIST from the PLAYLIST menu. All the 
playlists on disk are displayed. 

2. Select the playlist you wish to delete and press SEL. You are 
asked to confirm the request: DELETE PLAYLIST XX-XX-XX? 

3. Press YES to complete the deletion.

0001

0002

0003

0004

S

1-001

1-004

1-001

1-003

NEXT T

HDD:

CLIP:

00:00:01:23

00:00:02:00

  EXIT

CLIP INFO

01

0001

NEXT BACK

03-20-20

06-20-20

03-25-20

03-30-20

  EXIT SEL T
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2.5.9 HDD Bypass

HDD Bypass mode allows the connected FireWire hard drives to be 
mounted or dismounted to a computer without removing them from the 
FS-2E.

In this mode, the computer connects to the “HDD 
I/O” port on the FS-2/2E Rear Connector Panel.

1. To Exit this mode, press the EXIT key.
2. Be sure to properly dismount the FireWire drive from the computer 

system before exiting HDD Bypass mode on the FS-2/2E.

2.5.10 Internal HDD
The internal HDD function allows you to remove the front mounted IDE 
drive from FS-2/2E without first having to power the unit down. 

1. Select INTERNAL HDD by pressing the SEL button.
2. Answer YES to question, Remove Internal HDD? 

To abort, select EXIT. 
3. Remove the disk drive from the FS-2/2E when prompted. To remove 

the hard drive, push the latch on the front right of the drive to the 
right. The drive handle pops out from the face of the drive. Then 
carefully pull the drive out from the drive bay. Press EXIT to complete 
the process.

To reinsert the drive, slide it back into the drive bay and press the handle 
back into place until you hear a click. The drive will be recognized by the 
FS-2/2E after about a minute.

Attach FireWire Cable Before Enabling HDD Bypass
Before enabling HDD Bypass, attach a FireWire cable to the computer and HDD 
I/O port on the rear panel of the FS-2E. For more details, see Connecting the FS-
2/2E to a Network on page 98.

GO TO HDD

BYPASS?

EXIT YES NO
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2.5.11 Record Format Menu

The RECORD FORMAT menu allows selection of particular DTE 
Technology native NLE file formats prior to recording. All files are in the 
DV25 standard.

• The FS-2E supports the RAW DV formats:
• AVI TYPE1 
• AVI TYPE2 
• CANOPUS AVI 
• MATROX AVI 
• QUICKTIME 
• AVID OMF
• PINNACLE
• 24P AVI TYPE2*
• 24P QUICKTIME* 

* NTSC only.

1. Select a format to activate it. The highlighted format is the current 
format after exit.

2. Use T to scroll through the selections.
3. Press EXIT to return to the menu screen.

When recording in AVID OMF or PINNACLE AVI format, you must first do an 
Organize PINN or Organize OMF before using clips in an NLE. Refer to 
Utilities Menu on page 77 for more details.

RAW DV

AVI TYPE1

AVI TYPE2

CANOPUS AVI

MATROX AVI

QUICKTIME

EXIT S T
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2.5.12 Setup Menu

The SETUP menu allows you to set various functions of the FS-2/2E. 
• Select the menu item.
• Press SEL to open the sub menu (where applicable).
• Use T to scroll through the selections.
• Press EXIT to return to the menu screen.

The SETUP menu contains the following selections:
• SET DATE&TIME
• OS VERSION #
• OS UPGRADE
• PAL/NTSC
• RS422 REMOTE 
• AUDIO INPUT 
• AUDIO IN LEVEL
• TC MODE
• TC SET
• ON SCREEN DIS
• FF/RW HI RES
• GPI PORT
• BACKLIGHT
• STOP OUTPUT
• AUDIO CORRECT
• PREFERENCES
• FOLDER PREF
• ANALOG OUT
• NETWORK SETUP
• GENLOCK
• VIDEO OUT ADJ 

SET DATE&TIME

OS VERSION #

OS UPGRADE

PAL/NTSC 

EXIT SEL

X

X

X

X

T
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2.5.12.1 Set Date & Time

This selection provides a way to set date and time for file naming 
purposes. Date and Time are set in different menus.

1. Select the menu item. 

2. Press SEL to open one of the following sub menus. 

3. Move from field to field using the FORWARD and BACK 
INDEX Buttons.

4. Press S and T to scroll through digits in the value. 
5. Press EXIT to return to the menu screen. Regardless of the 

display, the file name always remains as follows:

YYYYMMDD-HHMMSS.xxx 
(Year-Month-Date-Hour-Minute-Second).

The date and time form the basis of the FS-2/2E file naming 
structure for use of clips on a computer.

On the FS-2/2E, files are identified by TRACK and VOLUME 
(disk drive) number on the LCD. For instance, a file on the FS-2/
2E LCD identified as 1-043 is clip number 43 on Volume (disk) 1.

SET DATE

SET TIME

EXIT SEL

X
X

T

SYSTEM DATE

10/01/07

MM/DD/YY

|WW & XX|
MOVES CURSOR

EXIT S T

SYSTEM TIME

17:20:12

Hh:Mm:Ss

|WW & XX|
MOVES CURSOR

EXIT S T
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On a computer, files are identified by their base file name made 
up of DATE and TIME. For instance, a clip named 20050615-
210943-01.mov is a clip that began recording at 9:09:43PM on June 
15th. 2005.

2.5.12.2 OS Version #

This selection displays the current FS-2/2E Operating System 
(OS) Firmware version.

DATE/TIME is used when creating file names only. The FS-2/2E does 
not record this information into the stream. The FS-2/2E records the date 
and time which is in the DV stream sent from the input source.

OS VERSION

2.0.2.01100606

EXIT
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2.5.12.3 OS Upgrade

To upgrade operating system (OS) software, you must download 
a new .bin file to a FireWire drive on your computer. The latest 
version of FS-2/2E software can be downloaded from http://
www.focusinfo.com/support.

There are three methods for installing new FS-2/2E software:

• Via the Web Interface, see Updating FS-2E Software via FTP 
on page 109. 

• Directly onto the FS-2/2E internal drive, see the following 
procedure. 

• From an external FireWire drive, see the following 
procedure.

To begin:

1. Download software from the Focus Website to your local 
computer. 

2. Unzip file using WinZip (Windows) or Stuffit (Macintosh) 
on a computer system with a FireWire (IEEE-1394) 
connection. 

3. Rename the unzipped file, XXXX.bin, to fs2.bin. 

2.5.12.3.1 Copy Software to FS-2/2E Internal Drive

To install new OS software onto the internal drive of 
the FS-2/2E, do the following:

1. Using a FireWire cable, connect the computer and 
FS-2/2E through the FS-2/2E port labeled, To 
HDD.

2. Copy the fs2.bin file to the internal drive of the 
FS-2/2E.

3. Enter the FS-2/2E menu and select SETUP.
4. From the SETUP menu, select OS UPGRADE. 

The following screen appears:

UPGRADE

SYSTEM

FIRMWARE?

EXIT YES NO
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5. Select YES. 
The following warning appears:

6. Select YES to begin the OS upgrade.
7. A message appears indicating the upgrade has 

begun. 
8. After upgrade is complete, power cycle the FS-2/

2E, to reboot the system. The new software is now 
loaded and ready to use. 

2.5.12.3.2  Load Software from External Drive 

Use this procedure to load new OS software into the 
FS-2/2E without copying it to the internal drive.

1. Power OFF the FS-2/2E.
2. Remove the drive from the FS-2/2E.
3. Connect the external FireWire drive with the new 

OS software to the FS-2/2E via its To HDD 1394 
connector. 

4. Power ON the FS-2/2E.
5. Follow steps 3 through 7 from the previous 

instruction, Copy Software to FS-2/2E Internal 
Drive.

6. Power OFF the FS-2/2E, disconnect the external 
FireWire drive and re-install the FS-2/2E internal 
drive.

7. Power ON the FS-2/2E.
This reboots the system and loads the software. It 
is now ready for use.

OS UPGRADE ERROR
If the FS-2/2E cannot find the .bin the LCD screen 
displays the message OS UPGRADE ERROR. 
Check the connections between the computer and 
the FS-2/2E and the upgrade file’s file name.

UPGRADE WILL

ERASE CURRENT

OS!!

CONTINUE?

EXIT YES NO
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2.5.12.4  Restoring the Factory Default Operating System 

To restore the factory default Operating System hold down the 
Left and Middle soft keys located under the LCD during boot up.

2.5.12.5 PAL/NTSC

Use this screen to select the record standard as either PAL or 
NTSC. The highlighted selection is the current one after exit. The 
FS-2/2E uses this video standard for both playback and record.

Do Not Combine PAL and NTSC Clips on the Same Drive.

NTSC

PAL

EXIT T
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2.5.12.6 RS422 Remote

This submenu allows you to setup the FS-2/2E for remote 
operation using the RS422 control port. 

For easy integration with existing control systems, you can make 
the FS-2/2E look like either a Sony BVW-75 Betacam SP deck or a 
generic recorder. Using the TC SOURCE submenu, you can also 
select the timecode source for FS-2/2E control. Options are ABS, 
DV and COUNTER.

You can set the FS-2/2E to two different remote modes:

• BVW-75 – The FS-2/2E appears as and is identified as a Sony 
BVW-75 BetaSP deck to the remote control device.

• Generic - The FS-2/2E appears as and is identified as a 
generic device to the remote controller.

After setting up the FS-2/2E’s RS422 to control using an external 
RS422 device:

• Press the REMOTE button on the front panel or select 
REMOTE from the Control Mode menu.

FS-2/2E Does Not Support All BVW-75 Control Functions
Some BVW-75 control functions are not available on the FS-2/2E. 
The FS-2/2E mainly responds to commands such as PLAY, STOP, 
REWIND, REC, FF, and so on. Commands such as Insert, Edit, 
and other specialty commands are not possible.
Refer to Supported RS-422 Commands on page 116 for more 
information on supported commands.

TYPE

TC SOURCE

EXIT SEL

X

X

T
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2.5.12.7 Audio Input

In this submenu, you can change the default audio input linked to 
a particular video input. 

Select the mode to activate it. 

1. Press SEL for the highlighted menu item to open the sub-
menu. In the sub-menu, the currently highlighted mode is 
the current mode after exit.

2. Press EXIT to return to the menu screen. These settings are 
saved on power down.

Each video input and its available audio inputs are listed below:
• Composite

• Analog Balanced Audio (default)
• AES/EBU Digital Audio

• Y/C (S-Video)
• Analog Balanced Audio (default) 
• AES/EBU Digital Audio

• Component 
• Analog Balanced Audio (default) 
• AES/EBU Digital Audio

• SDI
• Embedded (default) 
• Analog Balanced Audio 
• AES/EBU Digital Audio

• DV
• Embedded (default) 

There is a SETUP > AUDIO INPUT > SDI > EMBEDDED 
submenu that provides the following options:

• CHAN 1 and 2
• CHAN 3 and 4

The FS-2E provides the option to select channels 1 and 2 or 
3 and 4 of the embedded audio of the SDI input stream. This 
is an FS-2E feature only.

COMPOSITE

Y/C

COMPONENT

SDI

EXIT SEL

X

X

X

X

T
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2.5.12.8 Audio In Levels

This menu item allows you to set the audio input levels for FS-2/
2E. 

Adjust the audio level between -34.5dB and +4.5dB in 1.5dB 
increments.

2.5.12.9 TC Mode

This submenu allows you to select different timecode options for 
use when the FS-2/2E is recording. 

Select the mode. 

1. Press SEL to open the sub-menu. When you exit the menu, 
the highlighted menu item is the current mode.

2. Press EXIT to return to the menu screen. These settings are 
saved on power down.

EXIT

0.0dB

S T

|--------------X------------|

EXT TC

REC RUN

REGEN

FREE RUN

EXIT SEL

X

T
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This submenu contains the following selections:

• EXT TC - Whatever the incoming timecode, the FS-2/2E 
records it. You can select between SELECTED INPUT and LTC. 
Select the desired TC source:  

• Choosing EXT TC mode will clear any stored timecode 
value.

• REC RUN - In this mode, the FS-2/2E does the following:
• 1  Uses the last timecode number recorded + 1 as the 

timecode number for the first frame of the next record-
ing.

• 2  Uses the number entered by a setting in the TC PRE-
SET menu for the first frame of the next recording.

• The last number used is stored in the memory, so this 
mode persists across recording sessions.

• REGEN - After a disk is mounted (at startup, upon manual 
connect) and after the track list has been constructed, the FS-
2/2E looks at the last track and looks at the timecode number 
of the last frame in that track. The FS-2/2E stores that 
number for use as the TC value (+ 1) for the first frame of the 
next recording. If the drive is empty, the FS-2/2E uses the TC 
PRESET(+ 1).

• FREE RUN - When you enable FREE RUN mode, the FS-2/2E 
begins counting from the value stored. If you use the TC 
PRESET function, when the number is entered and the TC 
PRESET menu is exited, the FS-2/2E begins counting from 
that value.

Once a timecode value is set and the FS-2/2E is set to REC RUN or 
FREE RUN timecode settings, the TC preset value becomes the 
starting point for timecode. 

Selected Input TC Source
Composite, Component, & Y/C VITC

SDI LTC

DV Embedded DV TC

If the FS-2/2E is set to EXT TC when in SYNCRO SLAVE mode, 
EXT TC stops once the tape in the camcorder ends. Focus 
Enhancements suggests that you use a different TC mode when 
using SYNCRO SLAVE. NOTE: TC Preset cannot be changed 
while in the EXT TC mode.
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2.5.12.10 TC Set

This menu allows you to set Timecode values for various modes. 
It also allows the selection of drop or non-drop frame (NTSC only) 
settings.

Once a timecode value is set and the FS-2/2E is set to REC RUN or 
FREE RUN timecode settings, the TC preset value becomes the 
starting point for timecode. Use this menu as follows:

1. Display this menu item by selecting it. 
2. Press SEL to open the sub menu of choice. 
3. Press EXIT to return to the menu screen.
4. For TC PRESET, scroll from field to field using the 

FORWARD and BACK INDEX buttons. 
5. Press T and S to scroll through digits in the value. 
6. Press EXIT to return to the menu screen.

2.5.12.10.1 TC Preset

This selection allows you to set the starting timecode 
value for future recordings. 

1. For UB Preset, scroll from field to field using the 
FORWARD and BACK INDEX buttons. 

2. Press T and S to scroll through the hex digits in 
the value. 

The FS-2E, or FS-2 (with the 2.0 upgrade), has the added ability to delay 
the recorded timecode relative to the content.

TC PRESET

UB PRESET

TC DELAY

DROP/NON DROP

EXIT SEL

X
X

X

X

T

TC PRESET

00:00:00:00

|WW & XX|
MOVES CURSOR

EXIT S T
E Studio DTE Disk Recorder User Guide          



FS-2/2E Functions
3. Press EXIT to return to the menu screen. 

2.5.12.10.2 UB Preset 

2.5.12.10.3 TC Delay (FS-2E only)

The TC DELAY menu is only available for the FS-2E, 
or FS-2 (with the 2.0 upgrade). This menu allows you 
to delay the recorded timecode up to 29 frames.
TC DELAY: 00

1. Use S (middle soft key) and T (right soft key) to 
adjust the delay value. 

2. Press EXIT when done. 

2.5.12.10.4 Drop/Non Drop

For DROP and NON-DROP, select the mode. The 
highlighted mode is the current mode after exit. 
This selection is not applicable for PAL use. On the 
FS-2/2E display, DROP is identified by a semicolon (;) 
and NON-DROP by a colon (:).

1. Press EXIT to return to the menu screen. 

You cannot set UB values after selecting EXT TC mode in 
the TC MODE menu.

UB PRESET

00:00:00:00

|WW & XX|
MOVES CURSOR

EXIT S T

DROP

NON-DROP

EXIT T
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2.5.12.11 On Screen Display

This selection allows you to turn on or off the on-screen display 
on FS-2/2E's Monitor Output. The highlighted item is saved after 
exit.

When you select ABS, the absolute timecode value, or amount of 
time recorded to the disk, appears on the bottom center of the 
monitor output.

When you select TC, the TC (Counter) timecode value appears on 
the bottom center of the monitor output.

When you select MENU, the FS-2/2E Menu appears in the top left 
corner of the monitor output.

1. Press T and S to scroll though the selections. 
2. Press EXIT to return to the menu screen.

2.5.12.12 FF/RW Hi Res

This screen enables or disables the FS-2/2E forward and reverse 
search high resolution mode. When enabled the following search 
speeds are available:

• REVERSE: -30X, -25X, -18X, -15X, -12X, -10X, -8X, -5X, -4X, -
3X, -2X, -1/30, -1/15, -1/10, -1/6, -1/5, -1/3,-1/2

• FORWARD: +30X, +25X, +18X, +15X, +12X, +10X, +8X, +5X, 
+4X, +3X, +2X, +1/30, +1/15, +1/10, +1/6, +1/5, +1/3, +1/2

By repeatedly pressing the front panel OSD key, you can cycle between 
these modes.

ABS

TC

MENU

OFF

EXIT S T

ENABLE

DISABLE

EXIT S T
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• The highlighted mode is the current mode after exit.
• Press EXIT to return to the menu screen.

2.5.12.13 GPI Port

This menu allows you to change the setting of the GPI port. 

• The highlighted function is the current setting after exit. 
• Press EXIT to return to the menu screen.
• DISABLE - This selection allows you to connect a 3.5mm to 

DB9 cable to the GPI port (CBLA-0113-01) and control the 
FS-2/2E using RS232C from an external device. You can also 
use the FS-2/2E with the optional wired remote control unit 
(ACSS-0019-01). Purchase this item at the Focus 
Enhancements online store: 
https://www.focusinfo.com/webstore/webstore.asp.

The remaining three selections allow functions to occur from a 
simple contact closure as follows:.

• PAUSE/UNPAUSE -This selection allows control of pause and 
unpause during a record or playback session.

• INDEX (NEW FILE) - This setting creates a new file during a 
record session without losing any frames.

• REC SNAPSHOT - This setting records a single frame of video 
to a file. Each sequential use of this function captures another 
frame to the same file until stopped.

DISABLE

PAUSE/UNPAUSE

INDEX / NEW FILE)

REC SNAPSHOT

EXIT           S T
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2.5.12.14 Backlight

This selection enables or disables the FS-2/2E LCD backlight. 

• The highlighted state is saved after exit. 
• Press EXIT to return to the menu screen.

The ON setting leaves the LCD backlight on continuously and 
OFF setting turns it off.

AUTO OFF turns off the backlight after one minute. Press any 
keypad button on the FS-2/2E to turn the LCD backlight back.

2.5.12.15 Stop Output

Use this option to select the video displayed while the FS-2/2E is 
in STOP mode. The selected mode is the current state after exit.

• GRAY - A black screen appears. 
• NO OUTPUT - A blank screen appears; the DV output is 

turned off during STOP. 
• CLIP PREVIEW - The first frame of each clip is generated and 

shows on all outputs after 1 second if you pause on that clip. 
After pressing the Stop button twice, the screen appears 
black. Use either the Forward Index or Reverse Index to show 
the clip preview.

This setting does not effect E-E mode. 

ON

OFF

AUTO OFF

 EXIT S T

GRAY

NO OUTPUT

CLIP PREVIEW

CUSTOM

 EXIT S T
E Studio DTE Disk Recorder User Guide          



FS-2/2E Functions
• CUSTOM - The FS-2/2E looks on disk drive volume 1 for any 
clip named SPLASH.dv and always displays the first frame of 
that clip. You can name any RawDV clip Splash.dv and the 
first frame from that clip appears as the default output in 
STOP mode. 

2.5.12.16 Audio Correct

This sub-menu allows you to change the AUDIO CORRECTION 
setting on the FS-2/2E. 

• The highlighted state is saved after exiting.
• Press EXIT to return to the menu screen.

The AUDIO CORRECTION selection is an advanced feature of 
the FS-2/2E. You should use the factory default settings for most 
operations (Factory default is MEDIUM). 

Audio Correction mode allows you to alter the performance of the 
audio error corrector while recording. It is useful when recording 
to the FS-2/2E from tapes containing dropouts. Error correction 
only effects AVI 2, Canopus AVI, Matrox AVI, QuickTime, AVID 
OMF, Pinnacle, 24p QuickTime, and 24p AVI Type 2. It does not 
effect RawDV or AVI 1. The selections are:

• OFF - No audio correction.
• MEDIUM - (default) “Normal” clean tapes played back on a 

camcorder or other VTR with clean heads. When error 
correction occurs, the audio can be muted for brief periods of 
time.

• HIGH - For cases where there are visible picture disturbances 
and likely long audio dropouts (1/2 sec and up).

OFF

MEDIUM

HIGH

 EXIT T
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2.5.12.17 Preferences

This menu allows you to save and restore system preferences. 

When you select SAVE, you are prompted with the message SAVE 
CURRENT PREFERENCES?. Press YES and a file is written to the disk 
drive saving the current user settings.

When you select RESTORE the FS-2/2E searches for a saved user 
preference on the disk and if found, restores your preferences. 
Preferences are a snapshot of all settings that can be saved on the 
FS-2/2E.

 The following screen appears when the RESTORE completes. 

It is now time to restart the FS-2E.

The restart requires that the FS-2E to be powered off and then on.

PREFERENCES

SAVE

RESTORE

 EXIT SEL

X

X

T

PREFERENCES

RESTORED

PLEASE RESTART
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2.5.12.18 Folder Pref

The FOLDER PREF menu allows you to determine the folders to 
which your clips are moved when you choose to do a ORGANIZE 
CLIPS from the UTILITIES menu. This menu contains the 
following sections:

• SCENE MARK - default - only marks those clips you explicitly 
mark during record or playback.

• AUTO MARK - marks all recorded clips with the last selected 
FOLDER.

2.5.12.19 Analog Out

This screen provides two selections: Composite or Component.

• Composite - Use to select the Y output on the rear panel 
providing a composite signal.

• Component - When you select component out, you can also 
select either SMPTE, BETACAM, or MII output levels. 

The selected mode becomes highlighted after you select Exit.

These features are most easily used in conjunction with the optional 
wired remote control. This can be ordered at the Focus Enhancements 
on-line store: https://www.focusinfo.com/webstore/webstore.asp. 
The part number is ACSS-0019-01.

SCENE MARK

AUTO MARK

 

 EXIT SEL T

COMPOSITE

COMPONENT

 EXIT SEL T
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2.5.12.20 Network Setup

With NETWORK SETUP, you can connect the 
FS-2/2E to a network. When this is done, you can do FTP file 
transfers to or from the FS-2/2E or control the FS-2/2E using 
Telnet. The FS-2E, or FS-2, with the 2.0 software upgrade also 
allows you to control the FS-2 using your internet browser. 

FOCUS Enhancements is in no way liable for device security 
(Telnet and FTP). Contact your system administrator regarding 
the best security practices.

2.5.12.20.1 IP SETTINGS 

With the IP settings menu item, you can select either 
DHCP (the network provides the IP address) or a 
CUSTOM IP. 

• DHCP - If you select DHCP and then EXIT, the FS-
2/2E attempts to log onto the network. 

• When DHCP is the default, SEL is not shown. 
• When Custom IP is selected, SEL is displayed.

IP SETTINGS

USER/PASSWORD

VIEW IP INFO

SERVICES

EXIT SEL

X

X

X

X

X

T

X

X

X

X

T

DHCP

CUSTOM IP

 EXIT SEL

X

T
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• CustomIP - If you select CUSTOM IP, a submenu 
opens to ask you to enter an IP number, Sub Net 
Mask, and Gateway. 

If you do not have these values, contact your system 
administrator. The default values for the IP address 
are 000.000.000.000, Sub Net Mask 255.255.255.000 and 
Gateway 000.000.000.000.
To modify the custom IP values use the following 
steps:

1. Select the item to modify.
2. Press S to select the field to change. 
3. Use the T to increase the value (HINT: press the 

SHIFT key on the FS-2/2E front panel plus S to 
decrease a value). 

4. Values wrap back to zero once the maximum 
value has been entered. 

5. To modify the next item or set of values, press the 
NEXT key on the FS-2/2E front panel.

6. Once complete, press the SEL key when EXIT is 
highlighted to exit or the NEXT key to continue to 
modify items. 
Once you exit the menu, the FS-2/2E attempts to 
log into the network and one of two things hap-
pen:
If the FS-2/2E successfully logs onto a network, it 
displays NETWORK CONNECT SUCCEEDED. 
If the FS-2/2E is unable to log onto a network, it 
displays NET CONNECT FAILED. CHECK NETWORK 
CABLE. 

7. Press the VERIFY button on the FS-2/2E to take 
you back to the IP Settings menu to verify your 
values.

8. Press the EXIT button to take you back to the 
SETUP menu.

IP 

MSK

GWY

 EXIT 

 NEXT SEL

000.000.

  000.000

255.255.

  255.000

000.000.

  000.000
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2.5.12.20.2 USER/PASSWORD 

This screen allows you to set a username and 
password for the FS-2/2E. If you are unsure what 
username and password to use, contact your system 
administrator. 

• Username may have up to 4 characters. 
• Password may have up to 6 characters. 

To modify the username and password, use the 
following steps:

1. Select the item to modify and then press the right 
arrow key to select the field. 

2. Use S to increase the value (HINT: press the 
SHIFT key on the FS-2/2E front panel plus S to 
decrease a value). 

3. Values loop back to zero once the maximum 
value has been entered. 

4. To modify the next item, press the NEXT key on 
the FS-2/2E front panel. It is only possible to have 
one username and password per unit. The 
maximum number of characters for each is seven.

USER:

PASWD:

 EXIT

 SAVE

 NEXT

fs2

focus

S T
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2.5.12.20.3 VIEW IP INFO 

In cases where DHCP is being used, by selecting VIEW 
IP INFO, you can see the IP address that the network 
has provided the FS-2/2E. 
If the FS-2/2E is not connected to a network or was 
not able to successfully log on, this screen displays 
DHCP DISABLED NOT CONNECTED. Check your 
settings or contact your system administrator for 
further assistance.

2.5.12.20.4 SERVICES 

The SERVICES menu allows you to enable or disable 
any of these services: FTP, TELNET, or WEB 
connection. With each, it is necessary to enable or 
disable the function within the submenu.
Once FTP is enabled you can use your web browser or 
ftp utility to transfer files to and from the FS-2/2E.
With TELNET enabled, you can send commands to 
control the FS-2/2E with a telnet utility.
With WEB enabled, you can control the FS-2/2E from 
your web browser. Type in the FS-2/2E IP address 
into the address bar of your browser to start using the 
web interface. Only an FS-2E or FS-2 (with the 2.0 
firmware upgrade) has this option available.

IP 000.000

  000.00

MSK 255.255

  255.000

GW            000.000

                000.000

    NEXT    S  T

FTP

TELNET

WEB

 EXIT SEL

X

X
X

T
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Web Interface 
Use the web interface to control, change settings, edit 
playlists, and even delete tracks on the FS-2/2E.
Below is an example of the web interface. For more 
information about the web interface, see FS-2E Web 
Interface on page 99. 

Remote Use of HDD Bypass

HDD Bypass allows you to make your content files 
available on the host computer. This permits more 
efficient and flexible transfer of files using your 
available network. Consult your Operating System’s 
instructions on how to network a FireWire drive.
To set up the FS-2E for HDD Bypass:

1. Enable HDD Bypass from the System Config tab.

HDD Bypass

System Config Tab
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2. Connect a host computer to the TO COMPUTER 
port on the back of the FS-2E next to the EtherNet 
port.

2.5.12.21 GENLOCK

The GENLOCK menu allows you to select and adjust the reference 
video source and whether the video out will be locked to the 
reference video input in playback modes.

• SOURCE - Selects the source of the sync pulses used to time 
the output video during playback. Choices are:

• REF VIDEO - the reference video port on FS-2/2E's rear 
panel,

• FREE RUN - reference video is generated internally on 
the FS-2/2E. When this option is selected the menu is 
simplified and only the above selections are in the 
GENLOCK menu. 

• SC PHASE - Allows the subcarrier phase to be adjusted 
between +127 and -128. The default value is set at 0.

Press and hold either S or T for more than 3 seconds to 
change the value by increments of ten.

• H PHASE - Allows the horizontal phase to be adjusted 
between +127 and -128. The default value is set at 0.

Press and hold either S or T for more than 3 seconds to 
change the value by increments of ten.

Loop-Through or Terminated Output
If the loop-through jack is not connected, make sure the output is 
terminated using an external 75 ohm terminator.

FS-2E Backpanel

Ethernet
10/100 Base T

To Computer
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2.5.12.22 Video Out Adj

The VIDEO OUT ADJ menu options allow you to make 
adjustments to FS-2/2E analog output sources. 

• HUE (NTSC composite only) - adjustable between -179 and 
+180

• SATURATION (composite out only)- adjustable between -255 
and +256

• BRIGHTNESS (composite out only) - adjustable between -127 
and +128

• Y (component only) - adjustable between -128 and 128
• U (component only) - adjustable between -255 and 255
• V (component only) - adjustable between -255 and 255
• CONTRAST (composite out only) - adjustable between -127 

and +128
• BLACK LEVEL (NTSC composite only) - Allows the output 

black level to be set to either 0 IRE or 7.5 IRE. 0 IRE is the 
default setting. This menu item is only present when the FS-
2/2E is set to NTSC mode. 

2.5.12.23 Compnt Level

This is option is only available in NTSC mode and is not available 
in PAL mode.

Both the component inputs and outputs offer three video signal 
level standards:

• SMPTE
• BETA
• MII 
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2.5.13 Utilities Menu

This menu allows you to access various utilities. 
• Select the menu item. Press SEL to open the sub menu (where 

applicable).
• Press EXIT to return to the menu screen.

This menu contains the following selections:
• ORGANIZE PINN
• ORGANIZE CLIP
• ORGANIZE OMF
• DELETE CLIP
• FORMAT
• PARTITION
• REPAIR
• FILE NAME
• FACTORY RESET
• DIAGNOSTIC

2.5.13.1 Organize PINN

Once you have finished a Pinnacle recording session, do the 
following: 

1. From the SETUP menu, select ORGANIZE PINN. 
2. When prompted ORGANIZE PINNACLE CLIPS? Select YES. 
3. You can now remove the disk drive from to begin editing. 

Products such as the Pinnacle AVI file format were created for use 
with products such as Pinnacle Liquid Edition. The Pinnacle AVI 
file format creates three files simultaneously during a recording; 
an AVI video file and two separate WAV audio files labeled as left 
and right. An additional Edition.ale file per recording session is 
also created which contains timecode data. This file must be kept 
with the media. This is shown in the following illustration. 

ORGANIZE PINN

ORGANIZE CLIP

ORGANIZE OMF

DELETE CLIP

 EXIT SEL T
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Once clips have been imported into Liquid Edition, an Index file is 
created on the disk drive per clip. Do not delete this file since it is 
required to continue work in the particular project. The 
illustration below shows this.
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2.5.13.2 Organize Clip

This selection places all files that were identified as a KEEPER or 
were SCENE MARKED during recording into a folder marked 
KEEPER or the prenamed SCENE MARKING folders on the disk 
drive. These folders can be imported directly into most DV NLE 
bins.

2.5.13.3 Organize OMF

When files are recorded in the AVID OMF file format, this 
command automatically takes all the OMF and AIF audio files at 
the end of a recording session and places them into a folder on the 
disk drive named “OMFI MediaFiles”. When the disk is 
connected to a computer, this folder is recognized by Avid’s 
Media Tool feature enabling direct import of files into the Avid 
timeline.

For more information on using FS-2/2E clips in Avid, refer to 
Using FS-2/2E Recorded Avid OMF Clips on Avid Editing Systems 
on page 90.

If you have selected files as a KEEPER or they have been SCENE 
MARKED, you cannot use this feature and keep files in their selected 
folders. If you would like to use clips in KEEPER or SCENE MARKED 
folders in Avid, manually create the “OMFI MediaFiles” folder when your 
disk drive is on your computer and drag the desired clips into this folder.

ORGANIZE

KEEP CLIPS?

 EXIT YES NO

ORGANIZE

AVID OMF CLIP?

 EXIT

S

YES NO
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2.5.13.4 Delete Clip

• In the DELETE CLIP X-XXX screen, select between clips by 
pressing the XX and WW buttons. 

• If you select YES, a message appears indicating that the 
selected clip is being deleted.

• Press EXIT to return to the menu screen.

Once a clip has been deleted, the FS-2/2E display re-organizes the 
clip number sequence. For instance, if there are three clips on disk 
(1-001, 1-002, 1-003) and you delete clip 1-002, after delete is 
complete, clip 1-003 becomes clip 1-002. Base file names are not 
affected however.

2.5.13.5 Format Disk

1. Select between volumes by pressing the XXl and lWW 
buttons. 

It is generally not recommended to delete clips, since fragmentation may 
occur.

DELETE

CLIP 1-001?

BASE:

210612-165423

 EXIT YES

FORMAT DISK

VOLUME 1?

SIZE 115 Gig  

FREE 540 Min  

EXIT      YES NO
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2. Select the volume and press YES, the following screen 
appears:

3. When you select YES, a message indicating the formatting 
appears.

4. Press EXIT to return to the menu screen.

2.5.13.6 Partition 

1. Go to Utilities and select Partition.
2. The display shown above appears. 
3. Press Select.

The following display appears. 

FORMAT WILL

ERASE ALL DATA!!

CONTINUE FORMAT

 VOL. 1

 EXIT YES NO

Select Drive

SIZE       115 Gib

Disk         1 

FREE         524 Min 

EXIT      YES NO

Confirm Drive

Disk            1 

FREE 536 Min

Good Partition 

EXIT      YES NO
FS-2/2E Studio DTE Disk Recorder User Guide
81



FS-2/2E Functions

FS-2/2
82
4. Press Yes.
The following message appears.

Select Partition to partition a connected disk drive. When an 
unknown volume type (HDD) is connected to the FS-2/2E, the 
Partition process puts a FAT32 format onto the drive. It erases any 
previous partition and data. 

2.5.13.7 Repair

1. Select the desired function. 
2. Press SEL to make a selection. 
3. Press EXIT to return to the menu screen.

2.5.13.7.1 CHECK DISK 

This selection scans the entire volume for any errors.
Usually, if a file was corrupted during a recording, 
Check Disk alerts you of this.

FS-2/2E Does Not Support Multiple Partitions on Drives Less Than 
128GB
You cannot add multiple partitions an a single drive using the FS-2/2E.
With drives greater than 128G, the FS-2/2E creates multiple partitions. 
There will be a partition for each 128G of disk space available.

PARTITIONING VOLUME

CHECK DISK

CURRENT CLIP

 EXIT SEL

X

X

T
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2.5.13.7.2 CURRENT CLIP 

This selection performs a similar function, but on the 
selected clip only. If an error is found, the 
FS-2/2E prompts you to repair the problem. 
CURRENT CLIP repairs the last file in the current 
session if it has been damaged.

• Select between volumes by pressing the XX|  
and |WW buttons. Press EXIT to return to the 
menu screen.

2.5.13.8 File Name

This selection displays the base file name of the selected clip.

2.5.13.9 Factory Reset

When you select this function, the FS-2/2E reverts all settings and 
values back to its factory default state.

1. Press YES to start factory reset. 
2. Press EXIT or NO to exit from the menu. 

2.5.13.10 Diagnostic

This is a setting used for diagnosing field issues. Do not change it 
unless told to by Focus Enhancements Technical Support.

• Press EXIT to exit from the menu.   

Warning: Factory Reset is can not be undone!!!

CLIP 1-001

BASE:

20010612-166523

 EXIT

DIAG LVL:

 EXIT

00

S T
FS-2/2E Studio DTE Disk Recorder User Guide
83



FS-2/2
84
E Studio DTE Disk Recorder User Guide     



Chapter 3

Using the FS-2/2E
This chapter contains the following procedures:
How to Make a Recording page 86
How to Playback page 86
How to Put Recorded Clips on a Computer System page 87
How to Create a Playlist page 94
How to Mark Scenes page 95
Connecting the FS-2/2E to a Network page 98

To perform these procedures use input and output targets as illustrated in the 
following diagram. 

External VTR
Record Output

Camcorder
Video Source

Monitor
Display Output

Speakers
Audio OutputPlayback VTR

Video Source

FS-2/2E Rear Panel
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3.1 How to Make a Recording

1. Use the following procedure to make a recording using the FS-2/2E.
2. Make sure the FS-2/2E is connected to power and has been turned on using 

the power switch on the rear of the chassis.
3. Connect the required devices as explained in Chapter 1. For this example, that 

would include a video source (audio and video), speakers or headset if 
desired, and a monitor if desired.

4. Make sure the drive in the FS-2/2E has been formatted. If it is not, the LCD 
screen indicates that it has not been. Refer to the Utilities Menu on page 77.

5. Manually select the input source using the front panel buttons (that is, 
CMPST, Y/C, CMPNT, SDI, or DV).
Select the record format as follows:

• Press the Menu soft key.
• Select RECORD FORMAT.
• Select the desired format using the T soft key to highlight your selection.
• Press EXIT twice.

6. Press the red record button twice. (Pressing this button once places the FS-2/
2E in record-pause. Pressing it again starts the recording.) Timecode on the 
front panel LCD advances when recording begins.

7. Press STOP when you have finished the recording

3.2 How to Playback 

Use the following procedure to playback a recording using the FS-2/2E. 

This procedure assumes that you have already recorded material on the hard drive 
as explained in the previous section.

1. Select the desired clip by using the Forward Index and Back Index buttons. 
These buttons step you through the clips on the selected disk drive.

2. If more than one disk drive is connected, press the SHIFT and the Forward 
Index or Back Index key as required until the desired drive appears on the 
LCD.

3. Press the PLAY button once to begin playback.
4. Press the STOP button once to pause or twice to stop the playback.

In all cases, if a monitor is connected to the video output, it displays the signal going 
through the FS-2/2E.
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3.3 How to Put Recorded Clips on a Computer System

Once you have recorded clips to a FireWire disk drive using FS-2/2E, you can use 
those clips in most computer based DV NLE systems. 

Traditionally, in order to get footage into an NLE system, it was necessary to 
capture or digitize that footage utilizing a video capture card. Using the 
FS-2/2E recorded clips, you can skip this capture stage by just connecting a 
FireWire disk drive to your computer using an OHCI compliant IEEE-1394 
(FireWire) PCI card or connect direct from the FS-2/2E using the HDD Bypass 
mode (refer to HDD Bypass on page 50 for more information).

You can connect FireWire disk drives used with the FS-2/2E to any computer 
system that will read a FAT 32 volume. This includes Windows 98SE, Windows 
ME, Windows 2000, Windows XP and Mac OS9 and OS10.

Check the FOCUS Enhancements' website (www.FOCUSinfo.com) for more 
information.

In order to use the FS-2/2E recorded FireWire disk drives on a computer, you must 
have an active IEEE-1394 connection on your computer. You also must have loaded 
any required FireWire disk drive drivers onto your computer system. Consult your 
FireWire disk drive documentation for more information. 

Connect your FireWire disk drive to your computer system utilizing a standard 6-
pin to 6-pin FireWire cable and connect power to the drive if necessary.

Consult the FireWire disk drive documentation for more information.

This section contains the following subsections:
Mounting FireWire Disk Drives (Windows XP, 2000, 98SE and ME)          page 88
Using FS-2/2E Recorded Avid OMF Clips on Avid Editing Systems           page 90
Dismounting FireWire Disk Drives (Windows XP, 2000, 98SE and ME)     page 92
Mounting FireWire Disk Drives (Macintosh)                                                 page 92
Dismounting FireWire Disk Drives (Macintosh)                                            page 93
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3.3.1 Mounting FireWire Disk Drives (Windows XP, 2000, 98SE and 
ME)

1. On a Windows-based computer system, double click the My 
Computer icon on the top left hand corner of the desktop. You will see 
a window similar to the following:

2. Locate your FireWire disk drive. This will probably be labeled E:, F:, 
G:, and so on. (drive C: is usually your computer's main disk drive). 

3. Once you have identified it, double click on the FireWire disk drive. 
Once opened, you should see a window similar to the following: 
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The FireWire disk drive can contain several different files. Clips can appear 
as 

• RawDV (.dv)
• AVI Type 1

(YYYYMMDDHHMMSSa01)
• AVI Type 2 or 24p AVI Type 2

(YYYYMMDDHHMMSSb01)
• Canopus AVI 

(YYYYMMDD-HHMMSSb01)
• Matrox AVI 

(YYYYMMDD-HHMMSSm01 with a separate .wav audio file per track)
• Pinnacle AVI

(YYYYMMDD-HHMMSSp01 with two separate .wav audio files per 
track)

• QuickTime or 24p Quicktime (.mov)
• Avid OMF (.omf with two separate .aif audio files per track).

The FAT32 file system has a limitation such that any particular file cannot 
exceed 2GB in size. This equates to roughly 9 minutes of recording time.

When clips are being recorded to FS-2/2E that exceed 9 minutes in length, 
FS-2/2E automatically creates a new file without dropping any frames. 

The two clips have the same primary file name, however, the last two digits 
are different. 

The first 2GB part of the clip is labeled with “-01” after the primary file 
name. 

The second 2GB segment is labeled with a “-02”. Additional 2GB segments 
are labeled with a “-XX” number.

With most NLE systems on a Windows computer, it is possible to utilize 
clips within the timeline by selecting the clips on the source volume (in this 
case, the connected FireWire disk drive) and importing them directly into 
the NLE’s bin. 

Clips can then be immediately used in the NLE’s timeline. 

With FireWire disk drives such as the Focus Enhancements FSHDD-1, the 
drive itself is fast enough to directly stream the clips to the NLE eliminating 
the need to copy or transfer the clips before use.

When utilizing the Avid OMF file format, you must follow the following 
steps to import clips.
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3.3.2 Using FS-2/2E Recorded Avid OMF Clips on Avid Editing 
Systems
The Avid DV OMF file format was developed for use with Avid editing 
systems on Windows 2000, Windows XP or Mac 0S10. These include Avid 
Xpress Pro, NewsCutter, Media Composer Adrenaline, and Symphony 
(with the DV option).

The Avid DV OMF file format creates three files simultaneously; an OMF 
video file and two separate AIF audio files. On the computer's desktop, the 
files appear as shown in the next illustration.

On the FS-2/2E, the video file (OMF) and the audio files (AIF) appear as one 
track. 

If you delete an Avid DV OMF file, the FS-2/2E deletes the audio and video 
portions at the same time.

In order to use the FS-2/2E recorded Avid DV OMF files on your Avid NLE 
system from the external FireWire drive, use the following procedure.

1. Locate the external FireWire drive on your computer. 
If you have trouble, you can locate the name of the external drive by 
selecting My Computer on a Windows system. On a Mac, the FireWire 
drive should appear on the desktop.

2. Open the FireWire drive when you have found it and create a new 
folder named OMFI MediaFiles. 
To do this on Windows, select File > New > Folder from the pull down 
menu. 
On Mac, select File > New Folder. You must type OMFI MediaFiles 
correctly in order for Avid to see the disk drive. 
E Studio DTE Disk Recorder User Guide          



Using the FS-2/2E
3. Drag all the OMF and AIF files into the new folder (do not drag in the 
files titled Desktop DB or Desktop DF). 

4. Launch Avid. 
5. Once you have opened the desired project or created a new project, 

select Tools > MediaTool. The following window appears:

6. Locate and select the external FireWire drive under Media Drive(s). 

7. Ensure that Master Clips is checked and press OK. The following 
Media Tools Window appears:

8. Create a new bin (select File > New Bin) or open an existing bin in 
Avid. 

9. Once opened, select all items in the Media Tools window (select Edit > 
Select All). 

10. Drag the contents of the Media Tools Window into the bin. You can 
now use these clips in the Avid timeline.

If you are using the ORGANIZE OMF function on the FS-2/2E prior to using 
the disk on a computer, steps 2 and 3 are not necessary.

If the drive does not appear, check to make sure you have created the 
OMFI MediaFiles folder correctly with proper case and spacing. Also, 
check to see that the drive is properly connected and recognized by the 
computer). Under Project(s), select All Projects (This highlights all items 
in the Project(s) window). 
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3.3.3 Dismounting FireWire Disk Drives (Windows XP, 2000, 98SE and 
ME)
Once you have completed working with your disk drive on a Windows XP, 
Windows 2000, Windows 98SE or Windows ME computer system, you 
must dismount the drive before unplugging it. 

To do this, use the following procedure: 
1. Click the Safely Remove Hardware icon at the bottom right side of the 

Windows task bar as shown below.

2. The computer system prompts you to “remove” the connected 
FireWire disk drive. This begins the dismount process. 

3. Select the message by clicking on it. The computer dismounts the disk 
drive and notify you when it is safe to remove the volume.

3.3.4 Mounting FireWire Disk Drives (Macintosh)

1. On a Macintosh, start your computer and connect your FireWire disk 
drive to the computer utilizing a standard 6-pin to 6-pin FireWire 
cable. 
Consult your FireWire disk drive documentation for more 
information. 

2. Ensure the required FireWire disk drive drivers have also been loaded 
onto you computer system (consult your FireWire disk drive's 
documentation for more information). 

Even if your FireWire disk drive was bought for use on a Macintosh, you 
MUST first partition and format the drive as a FAT32 volume on the FS-2/
2E for it to work.
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When mounted, your FireWire disk drive should appear on the 
computer's desktop as shown below:

The FS-2/2E formatted disk drive appears as a FAT32 volume with a 
PC label. 

3. Once you have located your FireWire disk drive on the desktop, 
double click the disk icon to open it up. Once opened, you will see the 
following:

3.3.5 Dismounting FireWire Disk Drives (Macintosh)
Once you have completed working with your disk drive on a Macintosh 
computer system, you must dismount the drive before unplugging it. 

Do this as follows:
1. Select the disk drive on the computer's desktop. It is marked with a PC 

symbol. 
2. Drag the drive into the trash. This dismounts the particular disk drive.

This is not always the case on Version 10 of the Macintosh operating system 
however.
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3.4 How to Create a Playlist

Use the following procedure to create a simple playlist on the FS-2/2E.
1. Ensure no playlist is open. 
2. TO ADD A CLIP - Play a clip you wish to add to the playlist. Using the front 

panel buttons, press MARK IN and MARK OUT for the particular portion of the 
clip to add to the playlist. Both buttons will light.

3. Once marked, press the front panel PLAYLIST button. The MARK IN and 
MARK OUT key lights will go out. 

4. Navigate to the next clip and again mark in and out points followed by press-
ing PLAYLIST. 

5. Repeat steps 2 and 3 to add all desired clips. 
6. Once you have selected all the clips you wish to add to the playlist, stop play-

back and navigate to the PLAYLIST menu on the FS-2/2E.
7. Select SAVE and name the playlist. (It is also possible to modify your created 

playlist using the PLAYLIST > EDIT menu.
8. To playback the playlist, navigate to PLAY-FROM in the FS-2/2E menu and 

select PLAYLISTS. Select the desired playlist and then exit. The PLAYLIST but-
ton on the front panel will light.

All playback now comes only from the created playlist. 
E Studio DTE Disk Recorder User Guide          



Using the FS-2/2E
3.5 How to Mark Scenes

The FS-2/2E Scene Marking feature allows you to mark clips for placement in 
particular folders during recording, playback or stop mode. 

When a drive is formatted using FS-2/2E, ten folders are created numbered 0 
through 9. After the drive is formatted on FS-2/2E, you can connect the hard-disk 
drive to a computer and give each of these folders a custom name (if you need help 
mounting your FireWire hard-disk drive to your computer system, refer to How to 
Put Recorded Clips on a Computer System on page 87. To rename each folder, click 
on the folder name until it is highlighted, then type in the desired name of the 
folder. 

Folders are ordered on FS-2/2E in numerical followed by alphabetical order. For 
instance, if folders are named “Scene 1”, “Scene 2” and “Auditions”, they appear 
on FS-2/2E as “1 Auditions”, “2 Scene 1” and 2 Scene 2”. The folder number is 
added in front of the folder name on the FS-2/2E LCD display for easy 
identification when using the optional remote control commander keypads.

To create a custom order to Folders, Focus Enhancements recommended that you 
change the name to change the numerical/alphabetical order. For example place 
numbers at the beginning of the folder name to determine the key to folder 
assignments.

After you have selected your “mark to” folder, you are almost ready to mark your 
scenes. Before you can start marking, you must select the playlist that will contain 
your scenes. To do this, use the following steps:

1. Press the PLAYLIST button to bring up the playlist menu. 
2. Select either OPEN, to choose an existing playlist, or NEW, to create a new one. 
3. Exit the PLAYLIST menu by pressing the MENU button

Now you are ready to mark your scenes. 

Folder names cannot exceed eleven characters. 
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3.5.1 Marking Scenes
Use the following procedure:

1. Play your pre-recorded clip from the FS-2/2E.
2. When you encounter the start of your scene, pause the FS-2/2E and 

then press the MARK IN button. The MARK IN button should light up. 
3. Play your clip again to the end point and pause. 
4. Press MARK OUT. The MARK OUT button lights. 
5. Press the PLAYLIST button to save the marked scene. 
6. Mark the rest of your scenes using the same procedure.
7. When you have completed marking your scenes, you must save the 

playlist to disk. Stop the playback on the FS-2/2E and press PLAYLIST. 
8. Select the SAVE menu option, enter the playlist name.
9. Press NEXT, and then press YES to confirm your request to save the 

playlist. The playlists are saved in the PLAYLIST folder on your hard 
drive.

Advanced users can delete or change the order of scenes using the 
PLAYLIST > EDIT menu options. For FS-2E users, or FS-2 (with 2.0 upgrade), 
you can also use the web interface (shown below) to edit the current 
playlist. Use your browser to connect to the FS-2E, and select the PLAYLIST 
tab.

For more information about the FS-2E web interface, see FS-2E Web 
Interface on page 99.
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If the FS-2/2E PLAY FROM is set to TRACKLIST the name of the SCENE 
MARK, or assigned, folder appears without brackets on the LCD display (for 
example, 2 SCENE 2).

If the PLAY FROM menu is set to FOLDERS, the name of the assigned folder 
appears in brackets on the LCD display (for example, 2 <SCENE 2>.

Using the SCENE MARK menu, you can assign clips to folders using the 
numeric keypad on the optional remote control unit. To add all assigned 
clips to their respective folders on the disk drive, select
UTILITIES > ORGANIZE CLIP from the FS-2/2E menu. 

Once complete, an additional file is added to the disk named “grade” and 
files are moved to the selected folder for easy access on an NLE system.

Do not delete the file named “grade” from the disk if you intend to use the 
disk on FS-2/2E again.

COUNTER

00:00:00:00

DISK 1

<2SCENE 2>

 EXIT DISP

184 Min

SHFT
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3.6 Connecting the FS-2/2E to a Network

You can connect the FS-2/2E to a network using the Ethernet 10/100 Base T port on 
the rear panel. Do the following:

1. Use a standard RJ85 cable to connect between the Ethernet port on the rear 
panel to a network. 

2. Power up the FS-2/2E and make sure your network is functioning properly. 
Contact your system administrator for additional help.

3. Navigate to the FS-2/2E NETWORK menu. 
Once in the menu, open the IP SETTINGS sub menu. 

4. Select either DHCP (network supplies the IP address) or CUSTOM IP and 
enter the IP address, Sub Net Mask and Gateway). Exit when done.

5. If your network requires a user name or password, navigate to 
USER/PASSWORD and enter both. 

6. Exit the NETWORK SETTINGS menu and the FS-2/2E attempts to log onto 
the network. 

Make sure the services you intend to use are enabled. These are enabled using 
SETUP > NETWORK SETTINGS > SERVICES.

Use HDD Bypass Mode for Transferring Large Files 
The performance of transferring files utilizing the FS-2/FS-2E ftp server is not faster than real 
time. It is recommended that HDD Bypass mode is used to transfer larger files. The web 
control interface can be used to remotely place the FS-2E into HDD bypass mode. For more 
information, see HDD Bypass on page 50 and Web Interface on page 74. 

FS-2E Rear Panel

Ethernet 10/100 Base T Connector
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FS-2E Web Interface
The FS-2E may be configured and operated over the network via the FS-2E Web 
Interface. This application provides functions for recorder/player operations and a 
reduced set of system management functions similar to those accessed through FS-
2E front panel controls, see FS-2/2E Menus and Functions. This chapter contains 
information about the FS-2/2E’s web-based user interface: 

Web Interface Home Page page 100
The Web Interface page 101
Recorder/Player Controls page 101
Recorder Status page 102
Tracklist page 103
Recorder Configuration page 105
Playlist page 107
System Configuration page 108
Updating FS-2E Software via FTP page 109
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4.1 Web Interface Home Page

To open the Web Interface for a FS-2E, enter the IP address of that FS-2E in the 
browser address window and press Enter. 

JAVA Software for the Desktop
The Web Interface control functions require that the Java Runtime Environment be installed. 
Download this software from http://www.java.com.

Record / Play Controls

Recorder Config
Tracklist

Recorder Status System Config
Playlist
Tracklist
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4.2 The Web Interface

4.2.1 Recorder/Player Controls

The Record and Play buttons function in the same manner as controls on a 
video tape recorder (VTR) and the control panel buttons on the front of the 
FS-2E, see Front Control Panel on page 8 for more information.

4.2.1.1 Record

1. Verify that the input device is connected to the FS-2E.
Refer to Setting Up the FS-2/2E.

2. Verify that the FS-2E is properly configured to record. 
Refer to Recorder Configuration on page 105.

3. Select a video source and display it on a monitor.
4. Click on the Record button to start recording.
5. To pause recording, click on the Pause button.
6. To resume recording, click on Record time.
7. To create a new track without stopping the recording, click 

on Record while recording.
8. Click on the Stop button to halt the recording.

If allowed to run on its own, the FS-2E continues recording 
until the hard drive reaches full capacity and then stops.

4.2.1.2 Playback

1. The method of playback depends on the Playback Mode 
selected in System Configuration, see page 108.

2. In Track mode, select a track in either the Tracklist, see page 
103, and click the Play button. The track begins to play.

3. Click Play and the playlist begins playback.
4. Click Stop to end playback.

Rewind

Next Track

ForwardPlay     Pause     Stop     Record

Previous Track
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4.2.2 Recorder Status

The Recorder Status displays a log that lists hard drive activity that 
includes:

• User Password (at top of display),
• IP information (at top of display),
• File name and extension,
• File type (format),
• Number of frames in file,
• Timecode,
• Track length,
• Number of files in track,
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4.2.3 Tracklist

The Tracklist, which is available in both sets of tabs, is similar to a hard 
drive directory and displays the list of Tracks that may be used when 
creating playlist. Adding a track from this list to a playlist does not remove 
the track from the Tracklist. Likewise, deleting a track from a playlist does 
not delete the track from the tracklist.

Tracklist offers four list administration tools.
• Select All - Clicking this button selects all tracks listed. Check marks 

appear in all track check boxes. 
• Deselect All - Clears the check boxes for all selected tracks. 
• Delete - Removes any selected tracks.
• Add to Playlist - Adds any selected tracks to the playlist displayed in 

the Playlist form, see Playlist on page 107.

In addition, Tracklist provides three tools for each track. 
• Del - Deletes the highlighted track. It is not necessary to use the check 

box to select the individual track.
• Insert - Inserts the highlighted track into the playlist. Clicking on Insert 

opens the Insert Form. 
• Add - Inserts the selected track directly into the playlist without use of 

the Insert Form.

Clicking the Insert Icon 
Opens the Insert Form
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4.2.3.1 Adding Tracks to a Playlist 

1. To add multiple tracks to a playlist:
• Select the tracks by placing check marks in their check 

boxes. 
• Select the button Add to Playlist in the menu bar above 

the list of tracks. 
2. To add a specific video clip within a track to a playlist, enter 

the run-time and frame number of the first and last frames of 
the clip in the Mark In and Mark Out fields respectively. and 
specify its Mark In/Out times:

• Place the cursor over the Insert icon to the right of the 
track. The track is highlighted. 

• Click on the Insert icon. 
The Insert Form appears.

• Enter the Mark In/Out times in the Insert Form.
• Select Append to save and add the track to playlist.

3. To add an entire track to the playlist, without using Mark 
In/Out:

• Place the cursor over the Add icon to the right of the 
track. The track is highlighted. 

• Click on the Add icon.
• The track is added to the playlist.

4. Refresh the Playlist by selecting the Playlist tab. 
The displayed playlist does not show added tracks until the 
Playlist tab is selected and the list is refreshed.

4.2.3.2 Deleting Tracks from the Tracklist 

Before a track can be deleted, the Recorder and Player must be in 
Stop mode.
There are two methods for deleting a track: instantly or with 
confirmation.

1. Instantly 
This procedure deletes the track(s) immediately and offers 
no opportunity to reconsider.

• Select one or more tracks by clicking the Check box to 
the left of the track(s).

• Click Delete in the button bar at the top of the list.
2. With Confirmation 

This procedure includes a confirmation step as a safeguard.
• Select the track to delete.
• Click on the Delete icon to the right of the track.
• A confirmation window appears.
• Click Yes in the confirmation dialog window.
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4.2.4 Recorder Configuration 

Use the Recorder Config form to set up the FS-2E recorder function. 

The FS-2E provides the following Recording Settings: 

For specific details about the parameters listed below, see FS-2/2E Menus 
and Functions on page 30 and Using the FS-2/2E on page 85.

• Input Select - Pick the type of input signal:
• Composite, 
• YC, 
• Component, default 
• SDI, 
• DV, 

• Record Mode:
To start recording, click on the Record button. 
To stop recording, click on the Stop button.

• Normal, default 
• Retro Disk, 
• Retro Cache, 
• Loop Record, 
• Still, 
• Time Lapse, 

Failed to Change Value Please Try Again
The FS-2E detects if the selected input signal type is present. If the selected 
signal is not online, the message Failed to Change Value Please Try Again 
appears. Verify that the type of input signal and reset the Input Select field.
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• Record Format: 
•  Raw DV, 
• AVI Type 1, 
• AVI Type 2, 
• Canopus AVI, 
• Matrox AVI, 
• Quicktime, 
• Avid OMF, 
• Pinnacle, 
• 24P AVI Type 2, 
• 24P Quicktime, 

• Control Mode: 
• Local, default 
• Remote,
• AVC,
• Syncro Slave, 

• Audio Record Level: -34.5db to +4.5db, 0.0 default

• Syncro Record Pref: 
(Requires camera and tape, for details, see Syncro Slave on page 41.)

• Same File, default 
• New File,

• GPI Mode: 
• Off, default 
• Pause,
• Index, 
• Snap, 

• Audio Correction: 
• Off, 
• Medium, 
• High, 

• Time Code Mode: 
• External, default 
• Record Run, 
• Regen, 
• Free Run, 

• TC Delay: 0 to 29 seconds, 0 default 
• Saturation: -128 to +128, 0 default 
• Brightness: -128 to +127, 0 default 
• Contrast: -128 to +128, 0 default 
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4.2.5 Playlist

The FS-2E provides the ability to create simple playlists. The Playlist tab 
displays a listing of selected tracks in the order they are to play. In the 
button bar above the list, there are three playlist administration tools: 

• Select All - Clicking this button selects all tracks listed and check marks 
appear in all of the track check boxes. 

• Deselect All - Clears the check boxes for all selected tracks. 
• Remove - Removes any selected track from the playlist.

Remove only works with tracks in the playlist. The tracks displayed 
under Tracklist are not affected.

In addition, the Playlist form provides three tools for each track listed:
• Rem - Removes the highlighted track. It is not necessary to use the 

check box to select the individual track.
• Up and Down - Selecting one of these buttons moves the track up or 

down one line. 

Remove and Rem Do Not Ask for Confirmation 
Both Remove and Rem immediately delete specified tracks when their 
respective buttons are selected. These functions do not provide a confirmation 
step that allows cancellation. 
Use the Remove and Rem buttons with caution.
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4.2.6 System Configuration

FS-2E’s System Config form provides the ability to adjust system settings. 
When a system setting is changed, the FS-2E immediately applies it and 
refreshes the System Config form. For more information about these 
settings, see FS-2/2E Menus and Functions on page 30.

The system settings available through the web interface are:
•  HDD Bypass: 
• Play Mode: 
• Play List:
• Genlock Play Mode: 
• Backlight: 
• Clip Preview: 
• FTP: 
• Telnet: 
• OSD Mode: 
• FWD/REW Hi Res Mode: 
• Folder Preferences: 
• Organize Files: 
• Analog Out: 
• H Phase: 
• SC Phase: 
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4.3 Updating FS-2E Software via FTP

Periodically check the Focus Enhancements web site for FS-2E software updates, go 
to http://www.focusinfo.com/support.

Before uploading the software, verify the file name and determine that the FS-2E is 
enabled for FTP operations.

1. Unzip the update software and verify that the file name is fs2.bin. If not, 
rename the file.

2. Select the System Config tab.
3. Verify that FTP is enabled, see System Configuration on page 108.

4.3.1 Connecting with the FS-2E
Contact the System Administrator to get the FS-2E’s network IP address, 
logon, and password.

1. Open a browser.
2. Enter the FS-2E’s FTP address in the browser Address field.

The FS-2E factory default IP address is 192.168.0.102.
3. If the FS-2/2E is configured for a secure logon, the FTP path may be in 

the form ftp://logon:password@ipaddress; example 
ftp://fs2:focus@192.168.0.102.

4. Press Enter or select Go.
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5. If the FS-2/2E is configured for an anonymous logon a dialogue 
window appears:
Enter the Logon and Password: 
Factory default logon: fs2.
Factory default password: focus. 
Logon and password are case sensitive. 
It is not possible to change the logon or password through the web 
interface. Use the front panel controls, see Network Setup on page 70.

6. Select the directory VOL01. 
VOL01 is the root directory for the FS-2E.

7. Move the update software file to VOL01.
8. Exit the FTP session.
9. Go the FS-2/2E front panel controls.
10. Enter the FS-2/2E menu and go to the SETUP menu. 
11. From the Setup menu, select OS UPGRADE. 
12. Select YES and a confirmation message appears.
13. Select YES again to start upgrade using the new fs2.bin file.

Refer to OS Upgrade on page 55 for more information about the 
upgrading software through the LCD display and menu.

14. After the upgrade completes, reboot the FS-2E using the power switch 
on the back of the unit: power off and then on.

15. Verify that the upgrade is successful. 
Use the LCD and its soft keys to determine if the OS version has 
changed to the latest revision, see Setup Menu on page 52.

Two Methods for Updating FS-2/2E Software via 1394 To HDD Port 
There are two methods for updating the FS-2/2E OS software via the FS-2/2E’s 1394 To 
HDD connector:
The direct method, copies the software to VOL01 from a connected computer, see Copy 
Software to FS-2/2E Internal Drive on page 55. 
The other method, loads the software into the FS-2/2E without using its internal drive, 
see Load Software from External Drive on page 56.
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Chapter 5

Reference
This chapter contains reference information for the FS-2/2E as follows:
Technical Specifications page 112
FS-2/2E LCD Display Modes page 114
Supported RS-422 Commands page 116
Shuttle Speed Parameters page 116
Jog Speed Parameters page 117
Custom Commands page 117
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5.1 Technical Specifications

5.1.1 Inputs/Outputs

Input/Outputs
Component - Y, Pr, Pb (3 x BNC in, 3 x BNC out) 
SMPTE

• 100% white at 700mv with 300mv Sync
• 700mv Chroma levels (100% color bars)
• Setup default to OFF
• Chroma offset default to OFF

Betacam
• 100% white is at 714mv with 286mv Sync
• 4/3 Chroma boost to 934mv p to p
• Setup default to ON

 MII
• 100% white is at 700mv with 300mv Sync
• Black to White range is restricted to 647mv (700-setup)
• Setup is ON

Sync (1 x BNC in, 1 x BNC out) 

Composite (1 x BNC in, 1 x BNC out) 

Monitor Video Out - Composite (1 x BNC)

General Composite Specifications
• Differential Phase 2 Degree maximum
• Differential Gain 2% maximum
• Hue Accuracy 1 Degree
• Signal/Noise Ratio Greater than 54 dB
• Bandwidth 5.5 MHz
• K Factor % @ 2T 1 % maximum
• Y/C Delay Less than 25 nS
• Subcarrier locking range 100Hz
• Subcarrier free-run frequency    +/- 30 Hz 

                                             (NTSC or PAL Fsc deviation)
• Genlock Horizontal adjustment range   + 4 uS
• Residual Subcarrier Less than 0.5 IRE
• SC Phase Less than 2 degrees

S-Video - Y/C (1 x 4-pin DIN in, 1 x 4-pin DIN out) 

Levels Adjustments 
• Video Gain - +/- 20% 2mv resolution
• Chroma Gain - +/- 20% 2mv resolution
• Setup ON 

                                              (adds 7.5 IRE, or 53mv to luminance channel)
                                              OFF |(no change to luminance channel)

Serial Digital - SD-SDI (1 x BNC in, 1 x BNC out - conforms to the 
SMPTE 259M standard)

• The FS-2E outputs embedded audio in the SDI output stream. 
This feature is only available for the FS-2E.

Timecode (1 x BNC in, 1 x BNC out) 

Balanced Audio (2 x XLR in, 2 x XLR out) 
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5.1.2 Control 
• GPI & RS-232C Control (1 x 3.5mm mini jack) 
• RS-422 (1 x DB9 Serial) 

5.1.3 Power 
• 110V to 220V AC, 50 - 60 Hz, Auto Ranging 100W 
• IEC Power Input 

5.1.4 Physical Specification 
• 18.41lbs (8.36kg) 
• 19" x 17.3" x 3.5" (483mm x 440mm x 89mm) 

5.1.5 Audio/Video/Timecode Specification 
• 25Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video (user 

switchable) 
• SMPTE or DV embedded or External Timecode (Drop or Non Drop) 
• 2-ch., 16-bit embedded Digital Audio 

Stereo Audio Monitor (1 x 1/4” TRS jack) 

General Audio Specifications
Balanced Inputs

• Input Impedance 600 Ohms +/-10 Ohms
• Quantization 16 bits 48Khz
• Common mode rejection @1 KHz (dB)     100 dB
• Analog Input adjustment range  -34dB to +4.5dB 

                                                (in 1.5dB steps, default setting 0dB)
• Amplitude with no clipping 3.5Vp-p

Balanced Outputs
• THD@1 Khz Less than 0.05%
• Channel Separation 100 dBu (@ 1 Khz 70 dB)
• SNR 82 db, A weighted
• Quantization 16 bits 48Khz
• Output Impedance 600 Ohms +/-10 Ohms
• Bandwidth at -3dB points 24Khz 

 Headphone Output (1 x 1/4” TRS jack w/ level control)
• Headphone adjustment range -73dBdB to +4.5dB
• Headphone Output Impedance - 32 Ohms, 32mW

AES/EBU Digital Audio (1 x XLR in, 1 x XLR out) 

Reference Video Loop Through (2 x BNC) 

DV Video I/O - 25 Mb/s (1 x 6-pin IEEE-1394)

DV Video Pass Through - up to 400 Mb/s (1 x 6-pin IEEE-1394)

External HDD I/O - up to 400 Mb/s (1 x 6-pin IEEE-1394)

FireWire Computer I/F (1 x 6-pin IEEE-1394)

10/100 Base-T Ethernet
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5.1.6 DTE File Formats 
• FS-2 and FS-2E: RawDV (.dv), AVI Type 1, AVI Type 2, Canopus AVI 

and Matrox AVI (.avi), QuickTime (.mov), Pinnacle (.avi) or Avid DV-
OMF (.omf) 

• FS-2E (or FS-2 with 2.0 upgrade): 24P AVI Type 2, and 24P Quicktime.

5.1.7 Disk Information 
• Internal Disk Type: 120 GB, IDE, 7200 RPM 
• External Disk Type: User Supplied IEEE-1394a FireWire 
• Disk Format: FAT32 
• FAT32 FireWire HDD compatible with Windows 98SE, ME, 2000, XP 

and Mac OS9 and OSX Compliance and Warranty 
• CE, C-Tick and FCC 
• 2-Year Limited Warranty 

5.1.8 Compatible DV Formats 
• DV, MiniDV, DVCam and DVCPro 

5.2 FS-2/2E LCD Display Modes

The table below shows LCD characteristics when used with different FS-2/2E 
control, record, play and stop modes:

PLAY/REC Mode Command LCD Display
Stop STOP 
Pause ll PLAY 
Play X PLAY 
Rec (Pause) ll REC 
Normal Rec (Rec) REC 
Retro Disk (Stop) L STOP 
Retro Disk (Standby) L REC 
Retro Cache (Stop) C STOP 
Retro Cache (Standby) C REC 
Loop Record (Stop) O STOP 
Loop Record (Standby) O REC 
Loop Record (Rec) O REC 
Snap (Stop) STOP 
Snap (Standby) ll SNAP 
Snap (Rec) ll SNAP 
Time Lapse (Stop) STOP 
Time Lapse (Pause) ll T REC 
Time Lapse (Rec)   T REC 
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CONTROLTYPE LCD Display
AV/C* (Stop) A STOP 
AV/C* (Rec Pause) ll A <REC TYPE> REC 
AV/C* (Rec) A <REC TYPE> REC 
AV/C* (Play Pause) ll A PLAY 
AV/C* (Play) A ALL 
Syncro Slave (Pause) ll Y <REC TYPE>REC 
Syncro Slave (Rec) Y <REC TYPE>REC 

* AV/C is only for use when the FS-2/2E is connected to a 
computer system. To control the FS-2/2E from a camcorder, use 
Syncro Slave mode.
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5.3 Supported RS-422 Commands

5.4 Shuttle Speed Parameters

RS-422 Command
Shuttle FWD  21, 13, Shuttle Speed
Shuttle Rev  21, 23, Shuttle Speed
Jog FWD  21, 11, Jog Speed
Jog Rev  21, 21, Jog Speed
Stop  20, 00
Play  20, 01
Pause  21, 13, 0
Record  20, 02
Goto Timecode 24, 31, timecode

Command                          Parameters
Pause         0
Play Slow 6 1 to 100
Play Slow 5 101 to 200
Play Slow 4 201 to 300
Play Slow 3 301 to 400
Play Slow 2 401 to 500
Play Slow 1 501 to 999
Play Normal 1000 to 1999
Play Fast 1 2000 to 2999
Play Fast 2  3000 to 3999
Play Fast 3  4000 to 4999
Play Fast 4  5000 to 5999
Play Fast 5  6000 to 6999
Play Fast 6  7000 to 7999
Play Faster  8000 to 8999
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5.5 Jog Speed Parameters

5.6 Custom Commands

The following commands are currently supported.

Command                          Parameters
Pause       0
Step 1 Frame  1 to 200
Play Slow 4  201 to 300
Play Slow 3  301 to 400
Play Slow 2  401 to 500
Play Slow 1  501 to 800
Play Normal 1000 to 8999

Warnings
No feedback occurs indicating that the command was processed 
successfully.
The FS2/2E must be in STOP mode before sending these commands
Only positive values of contrast, saturation, H phase, SC phase, hue, and 
brightness are allowed
When deleting multiple tracks, delete the last track first, then work your 
way to the first track. A delete command causes the track list to be re-
built. Shifting all tracks up.
Send the CSUM command at the end of each command.
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Command                               Description
24 31 ## ## ## ## Goto TimeCode from start of track
48 80 82 2A ## 00 00 00 00 00 Goto Track ##   (Note 0 = track #1)
48 80 82 06 ## 00 00 00 00 00 Delete Track ##
48 80 82 0A 00 00 00 00 00 00 Record Mode Normal
48 80 82 0A 01 00 00 00 00 00 Record Mode retro disk
48 80 82 0A 02 00 00 00 00 00 Record Mode retro cache
48 80 82 0A 03 00 00 00 00 00 Record Mode loop record
48 80 82 0A 04 00 00 00 00 00 Record Mode still record
48 80 82 0A 05 00 00 00 00 00 Record Mode time lapse
48 80 82 0B 00 00 00 00 00 00 Snap Mode  Same File
48 80 82 0B 01 00 00 00 00 00 Snap Mode  New File
48 80 82 0C 00 00 00 00 00 00 Control Mode Local Control
48 80 82 0C 01 00 00 00 00 00 Control Mode Remote Control
48 80 82 0C 02 00 00 00 00 00 Control Mode AVC Control
48 80 82 0C 03 00 00 00 00 00 Control Mode Syncro Slave Control
48 80 82 0D 00 00 00 00 00 00 Play Mode  Play Clip (normal)
48 80 82 0D 01 00 00 00 00 00 Play Mode Loop Clip
48 80 82 0D 02 00 00 00 00 00 Play Mode Loop All
48 80 82 0D 03 00 00 00 00 00 Play Mode Play All
48 80 82 0E 00 00 00 00 00 00 Play From Play List
48 80 82 0E 01 00 00 00 00 00 Play From Track List
48 80 82 0E 02 00 00 00 00 00 Play From Grade List
48 80 82 0F 00 00 00 00 00 00 Record Format Raw DV
48 80 82 0F 01 00 00 00 00 00 Record Format AVI TYPE 1
48 80 82 0F 02 00 00 00 00 00 Record Format AVI TYPE 2
48 80 82 0F 03 00 00 00 00 00 Record Format CANOPUS AVI
48 80 82 0F 04 00 00 00 00 00 Record Format MATROX AVI
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Command                               Description
48 80 82 0F 05 00 00 00 00 00 Record Format QUICKTIME
48 80 82 0F 06 00 00 00 00 00 Record Format AVID OMF
48 80 82 0F 07 00 00 00 00 00 Record Format PINNACLE
48 80 82 0F 0B 00 00 00 00 00 Record Format AVI TYPE 2 - 24P
48 80 82 0F 0C 00 00 00 00 00 Record Format QUICKTIME - 24P
48 80 82 10 00 00 00 00 00 00 FTP        ENABLE
48 80 82 10 01 00 00 00 00 00 FTP        DISABLE
48 80 82 11 00 00 00 00 00 00 TELNET     ENABLE
48 80 82 11 01 00 00 00 00 00 TELNET     DISABLE
48 80 82 12 00 00 00 00 00 00 OSD        OFF
48 80 82 12 01 00 00 00 00 00 OSD MENU
48 80 82 12 02 00 00 00 00 00 OSD TC
48 80 82 12 03 00 00 00 00 00 OSD ABS
48 80 82 16 00 00 00 00 00 00 GPI OFF
48 80 82 16 00 00 00 00 00 00 GPI OFF
48 80 82 16 01 00 00 00 00 00 GPI        PAUSE
48 80 82 16 02 00 00 00 00 00 GPI        INDEX
48 80 82 16 03 00 00 00 00 00 GPI        SNAP
48 80 82 17 00 00 00 00 00 00 Backlight  OFF
48 80 82 17 01 00 00 00 00 00 Backlight  ON
48 80 82 17 02 00 00 00 00 00 Backlight  AUTO
48 80 82 18 00 00 00 00 00 00 Audio Correction OFF
48 80 82 18 01 00 00 00 00 00 Audio Correction  MEDIUM
48 80 82 18 02 00 00 00 00 00 Audio Correction HIGH
48 80 82 19 00 00 00 00 00 00 TimeCode Mode External 
48 80 82 19 01 00 00 00 00 00 TimeCode Mod Rec Run
48 80 82 19 02 00 00 00 00 00 TimeCode Mode Regen
48 80 82 19 03 00 00 00 00 00 TimeCode Mode Free Run
48 80 82 1A 00 00 00 00 00 00 Clip Preview On
48 80 82 1A 01 00 00 00 00 00 Clip Preview Off
48 80 82 1A 02 00 00 00 00 00 Clip Preview None
48 80 82 1A 03 00 00 00 00 00 Clip Preview Custom
48 80 82 1B ## 00 00 00 00 00 Brightness ##
48 80 82 1C 00 00 00 00 00 00 Input Select  Cmpst
48 80 82 1C 01 00 00 00 00 00 Input Select  Y/C
48 80 82 1C 02 00 00 00 00 00 Input Select  CMPNT
48 80 82 1C 03 00 00 00 00 00 Input Select  SDI
48 80 82 1C 04 00 00 00 00 00 Input Select  DV
48 80 82 1D 00 00 00 00 00 00 Audio Rec Level -34.5
48 80 82 1D 01 00 00 00 00 00 Audio Rec Level  -33.0
48 80 82 1D 02 00 00 00 00 00 Audio Rec Level -31.5
48 80 82 1D 03 00 00 00 00 00 Audio Rec Level  -30.0
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Command                               Description
48 80 82 1D 04 00 00 00 00 00 Audio Rec Level -28.5
48 80 82 1D 05 00 00 00 00 00 Audio Rec Level -27.0
48 80 82 1D 06 00 00 00 00 00 Audio Rec Level -25.5
48 80 82 1D 07 00 00 00 00 00 Audio Rec Level -24.0
48 80 82 1D 08 00 00 00 00 00 Audio Rec Level -22.5
48 80 82 1D 09 00 00 00 00 00 Audio Rec Level -21.0
48 80 82 1D 0A 00 00 00 00 00 Audio Rec Level -19.5
48 80 82 1D 0B 00 00 00 00 00 Audio Rec Level -18.0
48 80 82 1D 0C 00 00 00 00 00 Audio Rec Level -16.5
48 80 82 1D 0D 00 00 00 00 00 Audio Rec Level -15.0
48 80 82 1D 0E 00 00 00 00 00 Audio Rec Level -13.5
48 80 82 1D 0F 00 00 00 00 00 Audio Rec Level -12.0
48 80 82 1D 10 00 00 00 00 00 Audio Rec Level -10.5
48 80 82 1D 11 00 00 00 00 00 Audio Rec Level - 9.0
48 80 82 1D 12 00 00 00 00 00 Audio Rec Level - 7.5
48 80 82 1D 13 00 00 00 00 00 Audio Rec Level - 6.0
48 80 82 1D 14 00 00 00 00 00 Audio Rec Level - 4.5
48 80 82 1D 15 00 00 00 00 00 Audio Rec Level - 3.0
48 80 82 1D 16 00 00 00 00 00 Audio Rec Level - 1.5
48 80 82 1D 17 00 00 00 00 00 Audio Rec Level   0.0
48 80 82 1D 18 00 00 00 00 00 Audio Rec Level + 1.5
48 80 82 1D 19 00 00 00 00 00 Audio Rec Level + 3.0
48 80 82 1D 1A 00 00 00 00 00 Audio Rec Level + 4.5
48 80 82 1E 00 00 00 00 00 00 High Res Mode  Disable
48 80 82 1E 01 00 00 00 00 00 High Res Mode  Enable
48 80 82 1F 00 00 00 00 00 00 Folder Pref  Scene Mark
48 80 82 1F 01 00 00 00 00 00 Folder Pref Auto Mark
48 80 82 20 00 00 00 00 00 00 Reference Video Reference
48 80 82 20 01 00 00 00 00 00 Reference Video Free Run
48 80 82 21 00 00 00 00 00 00 Analog Out Composite
48 80 82 21 01 00 00 00 00 00 Analog Out COMPONENT-SMPTE
48 80 82 21 02 00 00 00 00 00 Analog Out COMPONENT-BETACAM
48 80 82 21 03 00 00 00 00 00 Analog Out COMPONENT-MII
48 80 82 22 01 00 00 00 00 00 Organize PINNACLE
48 80 82 22 02 00 00 00 00 00 Organize CLIPS
48 80 82 22 03 00 00 00 00 00 Organize OMF
48 80 82 23 ## 00 00 00 00 00 Contrast ##
48 80 82 24 ## 00 00 00 00 00 Saturation ##
48 80 82 25 ## 00 00 00 00 00 H Phase ##
48 80 82 26 ## 00 00 00 00 00 SC Phase ##
48 80 82 27 ## 00 00 00 00 00 Hue ##
48 80 82 28 00 00 00 00 00 00 Black Level 0 IRE
48 80 82 28 01 00 00 00 00 00 Black Level  7.5 IRE
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A
absolute timecode value 28
adding track to playlist 103
adding tracks to playlist 104
AES/EBU input/output 11
air temperature 5
analog out 69, 108
applications 3
audio correction 67, 106
audio input levels 60, 106
audiometer 28
AV/C 40
available space indicator 29
Avid DV OMF file format, editing 90

B
back index key 23
back search key 24
backlight 66, 108
balanced analog audio input/output 11
brightness 106
BVW-75 58
BVW-75 control functions 39

C
clip

loop 42
loop all 42
play 42
play all 42
preview 108

component
input 105

component inputs/outputs 76
component video (Y, R-Y, B-Y) key 21
composite

input 105
composite input/output 11
composite video source input key 21
configuring for recording 105

configuring the system 108
contrast 106
control mode

mode
control 106

control mode menu 38
current disk volume 29
current system status 27

D
default

IP address 109
logon 110
password 110

default audio input 59
default menu screen 27
delete clip 80
delete list 49
deleting 103
deleting tracks 104
DHCP 73
diagnostics 83
disk drive bay 8
disk drive, external 7
dismounting FireWire drives 92
DISP 29
display soft keys 9
DTE disk recorder 2
DV input 105
DV video source input key 22

E
edit buttons 17
E-E key 20
Ethernet connector 11

F
factory reset 83
FF/RW Hi Res 64
file name 83
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index 
file type 102
files

organize 108
folder

preferences 108
folder display 29
folder key 19
folder list 43
folder pref menu 69
format disk 80
formatting drives 13
forward index key 24
forward search key 25
FREE RUN Mode 61
front control panel 8
FTP 108, 109
fuse replacement 15

G
genlock play mode 108
GPI mode 106
GPI plug 10
GPI port 65

H
H phase 108
HDD bypass 108
HDD bypass key 20
headphones 9
hi res

fwd/rew 108
home page 100

I
IDE drive, inserting 7
illustration

home page 100
input sources 85
output targets 85
recorder configuration 105
recorder status page 102
web interface, record/play 101
web interface, tracklist 103

index at scene 39, 40
index at TC 38, 40
input

select 105
input buttons 17
installation 5
interface, web 99
internal HDD function 50
IP address

default 109

J
Java 100
Java Runtime Environment 100

K
keeper key 18
keypad lock key 20

L
LCD display 9, 26
LCD display soft keys 22
local 38
lock handle 7
logon 110
loop all 42
loop clip 42
loop record 36

M
MARK IN key 18
MARK OUT key 18
MENU 29
MENU key 23
menu system 30
mode

avc 40
control 38
fwd/rew hi res 108
genlock play 108
GPI 106
index at scene 39
local 38
OSD 108
play 42
remote 39
timecode 106

mode syncro slave 41
mounting FireWire disks 88

N
network connection 98
network setup 70
normal 38, 40
normal record 33

O
on screen display 20
organize clip 79
organize files 108
organize OMF 79
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organize Pinnacle 77
OS upgrade 55
OSD 20, 108

P
package contents 4
password 110
password/username 72
Pb input/output 10
phase

H 108
SC 108

PINN 77
play all 42
play clip 42
play from mode menu 43
play key 24
play list 43
play mode menu 42
play/record status symbol 27
playback

web interface 101
playback, front panel controls 86
player controls

web interface 101
playlist

adding track 103
removing track 107

playlist key 18
playlist menu 44
playlist, creating 94
power connection 11
power module, fuse replacement 15
power switch 8
Pr input/output 11
preferences 68

folder 108
preview

clip 108

R
rack mounting 6
rear panel 10
reboot 37
REC RUN Mode 61
record format menu 51
record key

red record key 24
RECORD MENU 33
record mode 27, 105

changing inputs 21
functions, record mode 30
loop record 36
normal record 33

retro cache 36
retro disk 35
still 37

record/play status indicator 27
recorded clips on disk drive, putting 87
recorder

configuration 105
recorder controls

web interface 101
recorder status 102
recording

front panel controls 86
recording, web interface 101
reference video 11
REGEN Mode 61
remote 39
REMOTE key 20
remote operation 58
repair disk 82
restore system preferences 68
retro cache 36
retro disk 34

record mode 34
RS-422 commands, supported 39
RS422 control 10
RS422 menu 58

S
saturation 106
SC phase 108
scenes, marking 95
SDI input 10, 105
SDI output 10
SDI video input key 21
services (internet) 73
set date and time 53
set timecode 62
setting up the FS-2/2E 12
SHFT 29
SHIFT key 24
site requirements 5
soft key one 29
soft key three 29
soft key two 29
soft keys 9, 33
software

updating 109
software updates 1
status

recorder 102
still

local 37
syncro slave 37

stop key 24
storage temperature 5
S-Video (Y/C) key 21
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index 
Sync input/output 11
syncro record preference 106
syncro slave 41

still 37
system configuration 108
system preferences 68

T
TC delay 63, 106
TC options 60
technical support 1
Telnet 108
time and date setting 14
time lapse 37
timecode 102
timecode input/output 11
timecode mode 106
timecode options 60
timecode/user bit display mode 28
timecode/user bit value 28
track

removing from playlist 107
track from tracklist 103
track length 102
tracklist 43, 103

adding track to playlist 103
delete track 103
deleting tracks 104

transport control keys 9, 23

U
Unpacking 3
updates, software 1
updating software

via FTP 109
upgrade operating system 55
user bit 28
username/password 72
utilities menu 77
utility buttons 17

V
video monitor output 11
video out adjustment menu 76
view IP information 73
volume number 27

W
web interface 99

home page 100
player controls 101
recorder configuration 105

recorder controls 101
recorder status 102
system config 108
tracklist 103

Y
Y/C input 11, 105
Y/C output 10
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